# Contents

**Introduction** .................................................. vii

**Chapter 1. What’s new?** ........................................ 1
New features in version 10.2 ........................................ 1
   IBM Cognos Data Manager 64-bit engine ......................... 1

**Chapter 2. Cognos Data Manager components** ................. 3
Cognos Data Manager engine .................................... 3
Cognos Data Manager Designer .................................. 3
Cognos Data Movement Service .................................. 4
Cognos Data Manager Network Services ......................... 4
Cognos Data Manager Connector for SAP R/3 .................... 4
Cognos Configuration ........................................... 4

**Chapter 3. Distribution options** ............................... 5
Install Cognos Data Manager Network Services .................. 5
Install Cognos Data Manager components on one computer ....... 6
   Install to the same location as other Cognos Business Intelligence components ..... 7
   Install to a different location than other Cognos Business Intelligence components .... 9
Install the Cognos Data Manager engine and Cognos Data Manager Designer on different computers ......................................................... 9
Install only the Cognos Data Manager engine .................... 11
Install multiple instances of the Cognos Data Manager engine . 11
Installing Cognos Data Manager Connector for SAP R/3 ......... 13
Security considerations ........................................... 14

**Chapter 4. Workflows to install and configure Cognos Data Manager** ................. 17

**Chapter 5. Installing Cognos Data Manager and Cognos Data Manager Connector for SAP R/3** ................................. 21
System requirements ............................................ 21
Installing the 64-bit version of IBM Cognos Data Manager .... 22
Installing Cognos Data Manager on Windows ...................... 22
Installing Cognos Data Manager on UNIX or Linux ............... 23
Installing Cognos Data Manager Connector for SAP R/3 ......... 24
   Installing the Cognos Data Manager Connector for SAP R/3 components ................. 25
   Installing the SAP gateway functions ........................................ 25
   Applying the SAP gateway functions ...................................... 26
   Installing the IBM Cognos compression utility ......................... 27
   Setting access permissions for the SAP gateway functions ...................... 28
Uninstalling Cognos Data Manager ................................ 29
   Uninstalling Cognos Data Manager on Windows .......... 29
   Uninstalling Cognos Data Manager on UNIX or Linux .... 29

**Chapter 6. Configuring Cognos Data Manager** ................ 31
Java settings .................................................... 31
Update your Java environment ..................................... 32
Starting Cognos Configuration .................................... 32
   Starting Cognos Configuration on Windows .................... 33
   Starting Cognos Configuration on UNIX or Linux ............. 33
   Default Settings for Cognos Data Manager ...................... 33
   Updating data and log file locations for Windows Vista .... 34
Configuring Cognos Data Manager Network Services ............ 35
   Changing the socket server port number and password .......... 35
   Changing the SOAP or secure SOAP server port number ....... 35
### Installation and Configuration Guide

Setting logging options for the server ........................................ 36
Configuring Cognos Data Manager clients to locate the Network Services server .......................... 36
  Setting logging options for the client ........................................ 37
Adding connections for additional Cognos Data Manager engines ........................................ 37
Setting data and log file locations ........................................ 38
Enabling or disabling Cognos Data Manager services ........................................ 38
Setting the Cognos Business Intelligence gateway and dispatcher connections ...................... 39
Saving your configuration settings ........................................ 39
Starting or stopping the Cognos Service ................. 40
Starting or stopping the Cognos Data Manager Network Services server .......................... 40
  Starting or stopping the socket server ........................................ 40
  Starting or stopping the SOAP server ........................................ 40
  Starting or stopping services on UNIX or Linux without a Java-based Interface .................. 41
Configuring Secure Sockets Layer for Cognos components ........................................ 41
  Configuring Cognos Data Manager for Secure Socket Layer ........................................ 41
  Setting up shared trust between Cognos Data Manager Network Services client and server ........ 43
Select and rank cipher suites for Secure Socket Layer ........................................ 44
Specifying the encoding to use for log files and reject files ........................................ 45
  Specifying the encoding to use for log files ........................................ 45
  Specifying the encoding to use for reject files ........................................ 46

### Chapter 7. Change application servers ............................... 47
Backing up existing Cognos information ........................................ 48
Setting environment variables ........................................ 49
Configuring Cognos components for your application server ........................................ 50
Building an application file to deploy to your application server ........................................ 50
Changing the application server startup script ........................................ 51
  Changing a WebSphere startup script ........................................ 51
  Changing a WebLogic startup script ........................................ 51
Configuring application server properties and deploying Cognos components ...................... 52
  Configuring properties and deploying Cognos components for WebSphere ...................... 53
  Configuring properties and deploying Cognos components for WebLogic ...................... 53
Enabling the secure socket layer ........................................ 54

### Chapter 8. Setting up an unattended installation and configuration. ............................... 57
Configuring a transfer specification file ........................................ 57
  Using a file generated by an installation on another computer ........................................ 57
  Using the response.ats file ........................................ 58
Running an unattended installation ........................................ 59
Exporting configuration settings from another computer ........................................ 59
Applying configuration settings to a new installation ........................................ 60

### Appendix A. Configuring Cognos Data Manager on UNIX or Linux without a graphical interface ............................... 61
Manually changing default configuration settings on UNIX or Linux ........................................ 61
Starting and stopping Cognos BI in silent mode on UNIX and Linux operating systems ............. 62
  Starting Cognos BI in silent mode on UNIX and Linux operating systems ...................... 62
  Stopping Cognos BI in silent mode on UNIX and Linux operating systems ...................... 63
Manually creating an application file to deploy to an application server ................................ 63
  Creating a WAR File ........................................ 63
  Creating an EAR File ........................................ 63

### Appendix B. Database environment variables ........................................ 65

### Appendix C. Changing the language of day and month names. ........................................ 71
Using French or German names for months and days ........................................ 71
Using another language for names of months and days ........................................ 71
Introduction

This document is intended for use with IBM® Cognos® Data Manager and IBM Cognos Data Manager Connector for SAP R/3.

The main purpose of Cognos Data Manager is to create data warehouses and data repositories for reporting, analysis, and performance management. Cognos Data Manager does this as follows:
- Extracting operational data from multiple data sources.
- Merging and transforming the data to facilitate enterprise-wide reporting and analysis.
- Delivering the transformed data to coordinated data marts.

This document describes how to install Cognos Data Manager on Microsoft Windows, UNIX, and Linux operating systems, and Cognos Data Manager Connector for SAP R/3 on Windows.

Audience

You should be familiar with the following:
- Database and data warehouse concepts.
- Security issues.
- Basic Windows or UNIX operating system administration.
- The existing server environment and security infrastructure in your organization.

Finding information

To find IBM Cognos product documentation on the web, including all translated documentation, access one of the IBM Cognos Information Centers (http://pic.dhe.ibm.com/infocenter/cogic/v1r0m0/index.jsp). Release Notes are published directly to Information Centers, and include links to the latest technotes and APARs.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility features

IBM Cognos Data Manager does not currently support accessibility features that help users with a physical disability, such as restricted mobility or limited vision, to use this product.

Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any variation of the Sample Outdoors or Great Outdoors names, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1. What's new?

This section contains a list of new, changed, deprecated, and removed features that affect installation and configuration for this release. It will help you plan your upgrade and application deployment strategies and the training requirements for your users.

For information about upgrading, see the IBM Cognos Data Manager Business Intelligence User Guide.

For information about new features for this release, see the IBM Cognos Business Intelligence New Features Guide.

What's New information for past releases, including versions 8.3 and 8.4, is available by accessing documentation within the IBM Cognos Business Intelligence 10.1.1 Information Center (http://pic.dhe.ibm.com/infocenter/cbi/v10r1m1/index.jsp).

To review an up-to-date list of environments that are supported by IBM Cognos Business Intelligence products, including information on operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, see the IBM Software Compatibility reports (www.ibm.com/support/docview.wss?uid=swg27037784).

New features in version 10.2

This section describes new features since the last release. Links to related topics are included where appropriate.

IBM Cognos Data Manager 64-bit engine

The 64-bit hybrid installation of IBM Cognos Data Manager now contains both 32-bit and 64-bit engines. This allows you to execute builds and JobStreams in 32-bit and 64-bit mode, if the operating system you are using is compatible with 64-bit.

If you run the 32-bit version of IBM Cognos Data Manager on a 64-bit operating system, you must have the 32-bit database drivers installed.

Note: If you are using IBM Cognos Data Manager Designer, for example to test database queries, you must also have the 32-bit drivers installed.

For more information about installing the 64-bit version of Cognos Data Manager, see “Installing the 64-bit version of IBM Cognos Data Manager” on page 22.
Chapter 2. Cognos Data Manager components

IBM Cognos components integrate easily into your existing infrastructure by using resources that are in your environment. Some of these existing resources are required, such as a Java™ Virtual Machine or another database.

Some Cognos components, including Cognos Data Manager Network Services, use an application server. Apache Tomcat is provided with IBM Cognos Data Manager, but you can configure Cognos components to run on supported application servers that you currently use in your environment.

Cognos Data Manager includes the following components:
- Cognos Data Manager engine
- Cognos Data Manager Designer
- Cognos Data Movement Service
- Cognos Data Manager Network Services
- Cognos Data Manager Connector for SAP R/3
- Cognos Configuration tool

Cognos Data Manager engine

The IBM Cognos Data Manager engine consists of a number of programs that you can run from either IBM Cognos Data Manager Designer (on a Windows operating system) or directly on the command line (on Microsoft Windows, UNIX, or Linux operating systems).

For most applications, IBM Cognos recommends that you design and prototype using Cognos Data Manager Designer on a Windows computer. You can then deploy your builds to either a Windows, UNIX, or Linux computer that has the Cognos Data Manager engine. However, you can also program the Cognos Data Manager engine directly in the Cognos Data Manager language.

The Cognos Data Manager engine can be installed on Windows, UNIX, or Linux computers.

Cognos Data Manager Designer

In IBM Cognos Data Manager Designer, you use builds to specify a set of processing rules that determine how Cognos Data Manager acquires data from the source databases, transforms the data, and delivers it to the target database. This information is stored in a Cognos Data Manager catalog.

Cognos Data Manager Designer can be installed only on Microsoft Windows operating systems.
**Cognos Data Movement Service**

The IBM Cognos Data Movement Service allows users to run and schedule builds and JobStreams on remote computers using IBM Cognos Connection, the user interface for IBM Cognos Business Intelligence. To use the Cognos Data Movement Service, Cognos BI must be installed in your environment, and the IBM Cognos Data Manager engine must be installed in the same location as the Cognos BI server components.

The Cognos Data Movement Service is automatically installed with the Cognos Data Manager engine. You must install the Cognos Data Manager engine in the same location as a Cognos BI server to be able to use this service.

**Cognos Data Manager Network Services**

Use IBM Cognos Data Manager Network Services to execute builds and JobStreams on remote computers from a Cognos Data Manager design environment computer. For example, if you installed the Cognos Data Manager engine on a computer with a UNIX or Linux operating system, you can also install the Cognos Data Manager Network Services server so that you can execute builds and JobStreams on that server from Cognos Data Manager Designer. If you do not install Cognos Data Manager Network Services, you must execute builds and JobStreams on remote computers using the command line or scripts.

Cognos Data Manager Network Services includes a server component that must be installed with the Cognos Data Manager engine. The server enables communication, either directly through a socket connection or through an application server, between Cognos Data Manager Designer and the Cognos Data Manager engine.

Cognos Data Manager Network Services also provides auditing functions when you run builds so that you can configure your environment if you intend to use more than one Cognos Data Manager engine.

**Cognos Data Manager Connector for SAP R/3**

IBM Cognos Data Manager Connector for SAP R/3 is an additional component that extends the data extraction capabilities of IBM Cognos Data Manager to include SAP R/3 data sources.

The installation program for Cognos Data Manager Connector for SAP R/3 is provided on a separate CD.

**Cognos Configuration**

IBM Cognos Configuration is a tool that you use to configure IBM Cognos components, and to start and stop services for Cognos components.

Use Cognos Configuration to configure IBM Cognos Data Manager to work with Cognos Data Manager Network Services, the IBM Cognos Data Movement Service, and other IBM Cognos Business Intelligence components.
Chapter 3. Distribution options

There are several different options for distributing IBM Cognos Data Manager components for an installation. There are also security issues that you must consider if you install the IBM Cognos Data Manager Network Services component.

You can install all Cognos Data Manager components on one computer, or install the IBM Cognos Data Manager engine and Cognos Data Manager Designer on different computers. The best distribution option depends on your requirements, resources, and preferences. Configuration requirements differ depending on whether you install all components on a single computer or on multiple computers.

IBM Cognos Business Intelligence is compatible with other IBM Cognos products. If your environment includes Cognos BI products, you must consider how Cognos Data Manager will fit into that environment. For example, Cognos BI and Cognos Data Manager can both use the same instance of IBM Cognos Configuration if they are installed to the same directory. If you install the Cognos Data Manager engine to the same location as an Cognos BI application server, you can use the IBM Cognos Data Movement Service to run and schedule builds and JobStreams using IBM Cognos Connection.

You must also decide whether you want to install Cognos Data Manager Network Services.

Other options include installing only the Cognos Data Manager engine or installing multiple instances of the Cognos Data Manager engine.

Install Cognos Data Manager Network Services

Whether you install the IBM Cognos Data Manager engine on the same computer or on a different computer than IBM Cognos Data Manager Designer, you must decide whether you want to install and use IBM Cognos Data Manager Network Services.

Attention: Cognos Data Manager Network Services is available only in 32 bit installations.

If you install the network services, you should consider the following:
- Which service protocol you want to use for the network services, either Sockets, SOAP, or Secure SOAP.
- Which application server you want to use if you choose the SOAP or Secure SOAP protocol.
- What security considerations you need for Cognos Data Manager Network Services.

If you do not want to interact with the Cognos Data Manager engine remotely, you do not have to install Cognos Data Manager Network Services. In this scenario, you use the Cognos Data Manager engine on different computers through command line options or scripts. For more information, see "Install only the Cognos Data Manager engine" on page 11.
Cognos Data Manager Network Services configuration

The configuration for the network services includes the name of the computer and the port number on which the IBM Cognos Data Manager Network Services server is running.

If you use Cognos Data Manager Network Services, you must install the Cognos Data Manager Network Services server on the same computer where you installed the IBM Cognos Data Manager engine. Then, you must specify the name of the computer and the port number for the server on the computer where you use the Cognos Data Manager Network Service clients, either IBM Cognos Data Manager Designer or the command line utilities.

Service protocol

IBM Cognos Data Manager Network Services can use Sockets, SOAP, or Secure SOAP network service protocols for communication. Sockets uses a direct connection, whereas SOAP, the default for IBM Cognos components, and Secure SOAP protocols require that you set up and configure an application server.

Application server

The IBM Cognos Data Manager Network Services installation includes Apache Tomcat, which runs the Cognos Data Manager Network Services server for SOAP or Secure SOAP protocols. If you use another application server with Cognos Data Manager Network Services, you must deploy the network services application to your application server and change your configuration settings.

Install Cognos Data Manager components on one computer

The default installation installs all IBM Cognos Data Manager components on one computer. You can choose this scenario for a proof of concept or demonstration environment.

Although, the IBM Cognos Data Manager Network Services components are installed in this scenario, you can choose whether to configure and use them. For example, you can execute builds and JobStreams on the computer without using Cognos Data Manager Network Services. However, you can also create a test environment and use Cognos Data Manager Network Services to provide communication between Cognos Data Manager Designer and the Cognos Data Manager engine.

Configuration options

If you install the components to the same directory, you can begin using Cognos Data Manager without any further configuration.

However, if you want to change the defaults or you want to test the Data Manager Network Services components or if other IBM Cognos Business Intelligence components are installed, you can set the following:

- The port numbers for the Data Manager Network Services server, including the Socket server port number, the SOAP or Secure SOAP port number, and the shutdown port number.
If other Cognos BI components are installed in the same location on the same computer, you can use the same application server port number for the SOAP or Secure SOAP protocols as is used for the Cognos BI dispatcher.

- Connections for the Data Manager Network Services clients - Cognos Data Manager Designer or the command line utilities - to locate the Data Manager Network Services server.
- The protocol for Cognos Data Manager Designer to use Sockets, SOAP, or Secure SOAP.
- The Cognos BI gateway and dispatcher locations if other Cognos BI components are installed.
- Log file locations.

If you do not use the Data Manager Network Services components, you must still set the host and port numbers for the Cognos BI gateway and dispatcher if you want to access Cognos data sources. You must then save your configuration before using Cognos Data Manager.

**Install to the same location as other Cognos Business Intelligence components**

If you have other IBM Cognos Business Intelligence components installed on a computer, IBM Cognos Data Manager can be installed to the same location.

Cognos Data Manager uses the same tools as Cognos BI, such as the application server that was set up for Cognos BI components and IBM Cognos Configuration.

Installing the IBM Cognos Data Manager engine into the same location as your Cognos BI Application Tier Components allows you to use the IBM Cognos Data Movement Service to run builds and JobStreams using the IBM Cognos Connection interface. Cognos Data Manager Designer users can execute builds using either the Cognos Data Movement Service or IBM Cognos Data Manager Network Services, if it has been installed. They can also execute builds locally.

Because the Cognos BI gateway must be located with the Web server, the single computer must also be running a Web server. If your Web server is on a UNIX or Linux operating system, you must install Cognos Data Manager Designer on a Microsoft Windows operating system.

In the following diagram, the Cognos Data Manager engine and all server components for Cognos BI, except IBM Cognos Framework Manager, are installed on one computer. Cognos Framework Manager and Cognos Data Manager Designer are located on another computer.
Configuration options

If you want to change the default settings, you can set any of the following:

- The port numbers for the IBM Cognos Data Manager Network Services server, including the socket server port number, the SOAP or Secure SOAP port number, and the shutdown port number.
  
  With other IBM Cognos Business Intelligence components installed to the same location on the same computer, you must use the same application server port number for the SOAP or Secure SOAP protocols than is used for the Cognos BI dispatcher.

- Connections for the Cognos Data Manager Network Services clients (Cognos Data Manager Designer or the command line utilities) to locate the Cognos Data Manager Network Services server.

- The protocol for Cognos Data Manager Designer to use Sockets, SOAP, or Secure SOAP.

- The Cognos BI gateway and dispatcher locations.

- Log file locations.

If you do not use the Cognos Data Manager Network Services components, you must still set the host and port numbers for the Cognos BI gateway and dispatcher if you want to access Cognos data sources. The values must be set for both the Cognos Data Manager Designer computer and the Cognos Data Manager engine computer.
Install to a different location than other Cognos Business Intelligence components

IBM Cognos Data Manager can also be installed to a different location on the same computer as other IBM Cognos Business Intelligence components.

If you are using the Data Manager Network Services, you must ensure that you change the port numbers so that Data Manager Network Services uses a port number that is different from the IBM Cognos service for your other Cognos BI components.

If you install the Cognos Data Manager engine to a different location than your IBM Cognos BI Application Tier Components, you will not be able to use the Data Movement Service to run and schedule builds using IBM Cognos Connection.

Configuration options

You must set the following:

- The port numbers for the Cognos Data Manager Network Services server, including the Socket server port number, the SOAP or Secure SOAP port number, and the shutdown port number.
  With other IBM Cognos Business Intelligence components installed on the same computer but in different locations, you must use a different application server port number for the SOAP or Secure SOAP protocols than is used for the Cognos BI dispatcher.

- The Cognos BI gateway and dispatcher locations, if you use Cognos Data Manager with other Cognos BI components.
  To use the Cognos Data Movement Service you must ensure the Cognos BI gateway value is set.

If you want to change the defaults, you can also set the following:

- Connections for the Cognos Data Manager Network Services clients (Cognos Data Manager Designer or the command line utilities) to locate the Data Manager Network Services server, including the port number if you are using a port other than the default.
- The protocol Cognos Data Manager Designer to use Sockets, SOAP, or Secure SOAP.
- Log file locations.

If you do not use the Cognos Data Manager Network Services components, you must still set the host and port numbers for the Cognos BI gateway and dispatcher if you want to access Cognos data sources. The values must be set for both Cognos Data Manager Designer computer and the Cognos Data Manager engine computer.

Install the Cognos Data Manager engine and Cognos Data Manager Designer on different computers

If you install the IBM Cognos Data Manager engine and IBM Cognos Data Manager Designer on different computers, you can choose to use Cognos Data Manager Network Services to communicate between the two.

Without the Data Manager Network Services, you can execute jobs on the Cognos Data Manager engine using the command line or scripts.
Use Cognos Data Manager Network Services

You must install the IBM Cognos Data Manager Network Services server with the IBM Cognos Data Manager engine, as shown in the following diagram.

If you want to change the defaults, you can set the following:

- The port numbers for the Cognos Data Manager Network Services server, including the socket server port number, the SOAP or secure SOAP port number, and the shutdown port number.

  If other IBM Cognos Business Intelligence components are installed on the same computer, you can use the same application server port number for the SOAP or Secure SOAP protocols that is used for the Cognos BI dispatcher.

- Connections for the Cognos Data Manager Network Services clients (Cognos Data Manager Designer or the command line utilities) to locate the Cognos Data Manager Network Services server.

- The protocol for Cognos Data Manager Designer to use sockets, SOAP, or Secure SOAP.

- The Cognos BI gateway and dispatcher locations if other Cognos BI components are installed.

- Log file locations.

Cognos Data Manager Network Services not used

This scenario is similar to the previous scenario, except that the jobs defined by IBM Cognos Data Manager Designer are executed on the IBM Cognos Data Manager engine computer from the command line or scripts.

If you want to change the defaults, you can set log file locations.
If you have other Cognos BI components installed, you must set the host and port numbers for the Cognos BI dispatcher and gateway if you want the Cognos Data Manager engine and Cognos Data Manager Designer to access those components. The values must be set for both the Cognos Data Manager Designer computer and the Cognos Data Manager engine computer.

**Install only the Cognos Data Manager engine**

The IBM Cognos Data Manager engine can be installed without any other IBM Cognos Data Manager components.

In this scenario, the engine is executed from the command line, and the jobs run by the Cognos Data Manager engine are also defined on the command line.

**Configuration options**

If you want to change the defaults, you can set log file locations.

If you have other IBM Cognos Business Intelligence components installed, you must set the host and port numbers for the Cognos BI dispatcher and gateway if you want the IBM Cognos Data Manager engine to access those components.

**Install multiple instances of the Cognos Data Manager engine**

You can install multiple IBM Cognos Data Manager engines in your environment. If you install IBM Cognos Data Manager Network Services, you can use IBM Cognos Data Manager Designer to select the engine for executing builds and JobStreams on from Cognos Data Manager Designer. If you do not install Cognos Data Manager Network Services, you must execute builds and JobStreams from the command line or through scripts.

**Use Cognos Data Manager Network Services**

You must install the IBM Cognos Data Manager Network Services server with the IBM Cognos Data Manager engine, as shown in the following diagram.
If you want to change the defaults, you can set the following:

- The port numbers for the Cognos Data Manager Network Services server, including the Socket server port number, the SOAP or Secure SOAP port number, and the shutdown port number.

  If other IBM Cognos Business Intelligence components are installed on the same computer, you can use the same application server port number for the SOAP or Secure SOAP protocols that is used for the Cognos BI dispatcher.

- Connections for the Cognos Data Manager Network Services clients (Cognos Data Manager Designer or the command line utilities) to locate the Cognos Data Manager Network Services server.

- The protocol for Cognos Data Manager Designer to use Sockets, SOAP, or Secure SOAP.

- The Cognos BI gateway and dispatcher locations if other Cognos BI components are installed.

- Log file locations.

**Cognos Data Manager Network Services not used**

If you do not install IBM Cognos Data Manager Network Services, the interaction with the IBM Cognos Data Manager engine is done from the command line or scripts.
If you want to change the defaults, you can set log file locations.

If you have other Cognos BI components installed, you must set the host and port numbers for the Cognos BI dispatcher and gateway if you want the Cognos Data Manager engine and Cognos Data Manager Designer to access those components. The values must be set for all computers where Cognos Data Manager Designer or the Cognos Data Manager engine are installed.

### Installing Cognos Data Manager Connector for SAP R/3

IBM Cognos Data Manager Connector for SAP R/3 must be installed on all computers where you have IBM Cognos Data Manager components if you want to use SAP R/3 as a data source for Cognos Data Manager.

For example, if you have Cognos Data Manager Designer and the Cognos Data Manager engine installed on different computers, you must install Cognos Data Manager Connector for SAP R/3 on both computers.

Cognos Data Manager Connector for SAP R/3 can be installed only on Microsoft Windows operating systems. Therefore, you can only install Cognos Data Manager components on Windows computers if you use Cognos Data Manager Connector for SAP R/3.

The SAP R/3 servers you use can be installed on Windows or UNIX operating systems.
Configuration requirements

You must do the following:
- Install the IBM Cognos Data Manager Connector for SAP R/3 components on your SAP server(s).
- Apply the IBM Cognos Data Manager Connector for SAP R/3 components using the SAP graphical user interface.
- Install the IBM Cognos Compression Utility on your SAP server(s).

If you have installed Cognos Data Manager Connector for SAP R/3 on several computers, you must perform these configuration steps only once for each SAP server.

Security considerations

IBM Cognos Data Manager Network Services is an optional component that allows IBM Cognos Data Manager builds and JobStreams to be executed and managed on remote servers.

It consists of a server component that processes requests and a client component, such as IBM Cognos Data Manager Designer or the command line utilities.

When any network communication components are installed, it is important to consider the security implications. Cognos Data Manager Network Services provides various options for ensuring the security of the Cognos Data Manager environment.

Dedicated users

By default, the IBM Cognos Data Manager Network Services processes are run using a privileged user account. We recommend that this account has the correct access controls for executing Cognos Data Manager builds and JobStreams required for your specific application. These processes should not be run using a local administrator account on a Microsoft Windows operating system or as a root user on UNIX or Linux operating systems.

On Windows, you can use the Control Panel to set up the user account that is to start the Cognos Data Manager Network Services server. On UNIX or Linux, ensure that the processes are started with the correct account profile.

To ensure that Cognos Data Manager starts, it is important to make sure that the account has access to the Cognos Data Manager executables and any temporary
directories. By default, the account must have read access to the installation location of the Cognos Data Manager software, and write access to the following directories:

- $c10_location/datamanager/data$
- $c10_location/datamanager/dsnetlog$
- $c10_location/datamanager/log$
- $c10_location/log$

**Use the service access password for security**

IBM Cognos Data Manager Network Services supports an enhanced security model that allows only specific Cognos Data Manager Network Services client computers to access a server. This requires that each client installation must be set up with a known service access password that is set for each server. Without this password, the server will not accept any request from a Cognos Data Manager Network Services client, even if a valid catalog database connection is provided.

When no customized security is enabled, a default security profile is used. You can change the service access password using IBM Cognos Configuration. This stops default clients from accessing the server.

Each Cognos Data Manager Network Services client that requires access to the server must be configured with the password for each of the servers that is to be accessed. You do this by setting the service access password on client computers using Cognos Configuration.

For more information, see [Chapter 6, “Configuring Cognos Data Manager,” on page 31](#).

**Enhanced security (HTTPS)**

By default, IBM Cognos Data Manager Network Services uses hypertext transfer protocol (HTTP) when transmitting using SOAP service protocol. However, security can be enhanced by using secure hypertext transfer protocol (HTTPS).

HTTPS is a standard encrypted communication protocol that is implemented using the secure sockets layer (SSL). HTTPS can only be used with Cognos Data Manager Network Services if you are using SOAP as your service protocol. Using HTTPS allows Cognos Data Manager Network Services to enforce authentication between server and client, as well as encrypting the transmitted data.

For more information, see [“Configuring Secure Sockets Layer for Cognos components” on page 41](#).
Chapter 4. Workflows to install and configure Cognos Data Manager

After you decide on the appropriate distribution options for your environment, you must follow a specific workflow to install and configure IBM Cognos Data Manager.

For example, follow one workflow to install on a single computer and another workflow to install on multiple computers.

The workflows do not include changing application servers. For more information, see Chapter 7, “Change application servers,” on page 47.

Tip: To ensure that you have completed all tasks, you can print the workflow that you plan to use as a checklist.

The following workflows show the required tasks for an installation on a single-computer, an installation using a remote connection to the IBM Cognos Data Manager engine, and an installation with other IBM Cognos Business Intelligence components.

**Single-computer Installation**
Remote installation of the Cognos Data Manager engine

Install
- Install Data Manager
- Set environment variables if you install on UNIX®
- Check default settings

Set up environment
- Update the Java™ environment of your Data Manager Engine on UNIX

Configure
- Configure Data Manager Network Services
- Configure Data Manager Designer to Locate the Network Services Server
- Save Your Configuration
- Start Data Manager Network Services

Installation with Cognos Data Manager Connector for SAP R/3

Install
- Install Data Manager
- Install IBM Cognos Data Manager Connector for SAP R/3
- Install and Apply the SAP Gateway Functions
- Install the IBM Cognos Compression Utility
- Check Default Settings

Configure
- Configure Data Manager Network Services
- Configure Data Manager Designer to Locate the Network Services Server
- Save Your Configuration
- Start Data Manager Network Services
Chapter 5. Installing Cognos Data Manager and Cognos Data Manager Connector for SAP R/3

The default installation installs all IBM Cognos Data Manager components on a single computer. However, you can select specific components to distribute to other computers.

You can install the IBM Cognos Data Manager engine on a UNIX or Linux operating system. If you are installing IBM Cognos Data Manager Connector for SAP R/3, you must install all Cognos Data Manager components on a Microsoft Windows operating system.

System requirements

Before you install IBM Cognos Data Manager, ensure that the computer meets all software and hardware requirements. The hardware requirements depend on your IBM Cognos environment. You may require additional resources, such as additional disk space.

*Table 1. Installation requirements for hardware and software*

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows</td>
</tr>
<tr>
<td></td>
<td>• Oracle Solaris</td>
</tr>
<tr>
<td></td>
<td>• HP-UX</td>
</tr>
<tr>
<td></td>
<td>• IBM AIX®</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux on Intel compatible x86</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum 1 GB</td>
</tr>
<tr>
<td>Operating system</td>
<td>File descriptor limit set to 1024 on Solaris (recommended)</td>
</tr>
<tr>
<td>specifications</td>
<td></td>
</tr>
<tr>
<td>Disk space</td>
<td>Minimum of 1 GB of free space on the drive that contains the temporary directory used by Cognos components</td>
</tr>
<tr>
<td>JRE</td>
<td>Java Runtime Environment (JRE)</td>
</tr>
<tr>
<td></td>
<td>JRE is installed automatically with Cognos Data Manager on Windows</td>
</tr>
<tr>
<td></td>
<td>If you are using an application server, use the JRE that is installed with it</td>
</tr>
<tr>
<td>Other</td>
<td>For a terminal emulator to install Cognos Data Manager on UNIX, the emulation should be set to VT220 equivalent or better to ensure that the hot keys in the Installation wizard work</td>
</tr>
<tr>
<td></td>
<td>On Windows, Microsoft Data Access Component (MDAC) for use with product samples</td>
</tr>
</tbody>
</table>

Cognos Data Manager requires that you have the appropriate database client drivers installed on any computer where Cognos Data Manager Designer or the Cognos Data Manager engine are installed.
To review an up-to-date list of environments that are supported by IBM Cognos Business Intelligence products, including information on operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, see the IBM Software Compatibility reports (www.ibm.com/support/docview.wss?uid=swg27037784).

If you are installing IBM Cognos Data Manager Connector for SAP R/3, you must ensure that you have a SAP Runtime Client installed because this is used to communicate with the SAP server environment. The runtime client must be installed on the same computer as Cognos Data Manager Designer, and on any computer where the Cognos Data Manager engine is installed.

The SAP Runtime Client is typically installed during the SAP graphical user interface client installation. Contact your SAP system administrator to confirm that the SAP Runtime Client is installed.

For UNIX or Linux installations, you should install and run all IBM Cognos processes as the same distinct user. For example, you can create a user named ibmcognos to install and run the processes. This user does not require root privileges to install or configure IBM Cognos products.

For information about setting database environment variables, see “Database environment variables,” on page 65.

### Installing the 64-bit version of IBM Cognos Data Manager

When you install the 64-bit version of IBM Cognos Data Manager, the default installation directory is different to 32-bit version.

The following table lists the default installation directory that is used by Cognos Data Manager depending on the version that you install.

**Table 2. Default paths for 32-bit installations**

<table>
<thead>
<tr>
<th>For a 32-bit Installation on</th>
<th>Default path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows operating systems</td>
<td>C:\Program Files\IBM\Cognos\c10</td>
</tr>
<tr>
<td>64-bit Microsoft Windows operating systems</td>
<td>C:\Program Files (x86)\IBM\Cognos\c10</td>
</tr>
</tbody>
</table>

**Note:** If you run the 32-bit version of IBM Cognos Data Manager on a 64-bit operating system, you must have the 32-bit database drivers installed.

**Table 3. Default paths for 64-bit installations**

<table>
<thead>
<tr>
<th>For a 64-bit Installation on</th>
<th>Default path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows operating systems</td>
<td>C:\Program Files\IBM\Cognos\c10_64</td>
</tr>
<tr>
<td>UNIX operating systems</td>
<td>/usr/IBM/cognos/c10_64</td>
</tr>
<tr>
<td>Linux operating systems</td>
<td>/opt/IBM/cognos/c10_64</td>
</tr>
</tbody>
</table>

### Installing Cognos Data Manager on Windows

This topic describes how to install IBM Cognos Data Manager on a Microsoft Windows operating system.
Procedure

1. Insert the Cognos Data Manager product disk or go to the location where the installation files were downloaded.
   The Installation wizard starts automatically from the product disk.
   If no Welcome page appears, go to the operating system directory and double-click the issetup.exe file.
2. Follow the directions in the Installation wizard.
   If you are installing Cognos Data Manager on a computer that already has IBM Cognos Business Intelligence installed, you can install Cognos Data Manager to the same directory or to a different directory.
   If you are installing in a directory that already has other Cognos BI components, you are prompted to create backup copies of files that are overwritten during installation.
3. In the Finish page of the Installation wizard, click Finish.
   • If you want to configure IBM Cognos components immediately, select Start IBM Cognos Configuration.
   • If you want to see late-breaking information about IBM Cognos components, select View the Readme.

Installing Cognos Data Manager on UNIX or Linux

This topic describes how to install IBM Cognos Data Manager components on a UNIX or Linux operating system.

Procedure

1. Insert the Cognos Data Manager product disk.
2. Set the JAVA_HOME environment variable to point to the installation location of your Java Runtime Environment (JRE). For example /directory/java/ java_version/jre.
   If you are installing Cognos Data Manager Network Services, the installation requires a JVM, such as IBM Java, to run on Linux.
3. On HP-UX, set the _M_ARENA_OPTS environment variable as follows:
   _M_ARENA_OPTS 1:4
   This increases the memory allocation for HP-UX to more closely match that of other UNIX platforms.
4. If installing from a disk, mount the disk using Rock Ridge file extensions.
   To mount the disk on HP-UX, do the following:
   • Add the pfs_mount directory in your path.
     For example,
     PATH=/usr/sbin/:$PATH
     export PATH
   • To start the required NFS daemons and run the daemons in the background, type bg pfs_mountd and then type bg pfsd
   • To mount the drive, type
     pfs_mount -t rrip <device><mount_dir> -o xlat=unix
     For example,
     pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd
and pfs_mountd daemons to unmount the disk.

5. To start the Installation wizard, go to the operating system directory and, if
you are using XWindows, type the following command:

```
./issetup
```

If you do not use XWindows, run an unattended installation. For more
information, see Chapter 8, “Setting up an unattended installation and
configuration,” on page 57.

6. Follow the directions in the Installation wizard.

Install Cognos Data Manager components in a directory that contains only
ASCII characters in the path name.

If you are installing Cognos Data Manager on a computer that already
has Cognos BI installed, you can install Cognos Data Manager to the same
directory or to a different directory.

If you are installing in a directory that already has other Cognos BI
components, you are prompted to create backup copies of files are overwritten
during the installation.


   • If you want to configure Cognos components immediately, select Start IBM
     Cognos Configuration.
   • If you want to see late-breaking information about Cognos components,
     select View the Readme.

8. Create an environment variable named COG_ROOT, and set the value to
    `c10_location/`

9. If you have installed Data Manager Network Services, append the
    `c10_location/bin` directory to the PATH environment variable.

10. To be able to run Cognos Data Manager from outside the bin directory,
    append the `c10_location/bin` directory to the PATH environment variable and
to the appropriate library path environment variable:
    • For Solaris, LD_LIBRARY_PATH
    • For AIX, LIBPATH
    • For HP-UX, SHLIB_PATH

11. To be able to run a published data movement task, append the
    `c10_location/bin` directory to the PATH environment variable.

---

## Installing Cognos Data Manager Connector for SAP R/3

IBM Cognos Data Manager Connector for SAP R/3 extends the data extraction
capabilities of IBM Cognos Data Manager so that you can access SAP R/3 data
sources in the same way as you would any other relational database system.

You must do the following to install Cognos Data Manager Connector for SAP
R/3:

   • Install Cognos Data Manager Connector for SAP R/3 components.
   • Install the SAP Gateway functions.
   • Apply the SAP Gateway functions.
   • Install the IBM Cognos compression utility.
   • Set access permissions for the SAP Gateway functions.
Installing the Cognos Data Manager Connector for SAP R/3 components

IBM Cognos Data Manager Connector for SAP R/3 can be installed only on a Microsoft Windows operating system.

Cognos Data Manager Connector for SAP R/3 must be installed on all computers where IBM Cognos Data Manager components are installed. To use Cognos Data Manager Connector for SAP R/3, all of your Cognos Data Manager components must be installed on Windows. The SAP R/3 servers you use can be installed on Windows, UNIX or Linux operating systems.

Install Cognos Data Manager Connector for SAP R/3 only after you install other Cognos Data Manager components, and install it to the same location as other Cognos Data Manager components.

Cognos Data Manager Connector for SAP R/3 is provided on a separate CD. Ensure that you insert the correct CD into your computer.

Procedure
1. Insert the Cognos Data Manager Connector for SAP R/3 CD.
   The Welcome page of the Installation wizard should appear. If no Welcome page appears, in the win32 directory on the CD, double-click the issetup.exe file.
2. Follow the instructions in the Installation wizard.
   Ensure that you install Cognos Data Manager Connector for SAP R/3 only after you install other Cognos Data Manager components. You must install it to the same location as other Cognos Data Manager components.
3. Click Finish.

Installing the SAP gateway functions

IBM Cognos Data Manager Connector for SAP R/3 uses Advanced Business Applications Programming (ABAP) function modules that interface with the SAP environment. The gateway functions must be installed on each SAP server in your environment and should be installed by a SAP system administrator.

The installation of the ABAP function modules varies for different versions of SAP. The module files are located the c10_location\transports directory. A separate directory is created for each version of SAP that is supported.

Note: If you are using SAP ERP Core Components (ECC5 or ECC6), you must use the ABAP function modules in the c10_location\transports\v47 directory.

If you install Cognos Data Manager Connector for SAP R/3 on different computers, you only have to install the gateway functions on each SAP server once.

Installing the gateway functions on Microsoft Windows
This topic describes how to install the SAP gateway functions on a SAP server running on a Microsoft Windows operating system.

Procedure
1. Copy the file named Knn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\cofiles directory on the SAP server.
2. Copy the file named Rnn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\data directory on the SAP server.

Results

You can now apply the functions.

Installing the gateway functions on UNIX or Linux

This topic describes how to install the SAP gateway functions on a SAP server running on a UNIX or Linux operating system.

You must copy the gateway functions from the computer with a Microsoft Windows operating system where you installed IBM Data Manager Connector for SAP R/3 to the UNIX or Linux computer where SAP is running.

Procedure

1. Use file transfer protocol (FTP) in ASCII mode to copy the file named Knn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\cofiles directory on the SAP server.
2. Use FTP in binary (bin) mode to copy the file named Rnn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\data directory on the SAP server.

Results

You can now apply the functions.

Applying the SAP gateway functions

After you install the SAP gateway functions, you must apply them using SAP GUI. Applying the functions should be performed by a SAP system administrator.

Even if you install IBM Cognos Data Manager Connector for SAP R/3 on different computers, you only have to install the gateway functions on each SAP server once.

Procedure

1. In the SAP GUI, start an STMS transaction.
2. Click Imports, and then double-click the queue name.
3. If a message appears prompting you to add to the import queue, click Yes and, if required, type your password.
4. Click Extras > Other Requests > Add to load the transport request into the application queue.
5. In the queue, select the transport request name matching the name in the readme.txt file.
6. From the Request menu, click Import and type the target client number.
7. Click Start Import, and then click Yes. If required, type the password.
8. If you want to check the result, click Logs.

You can now install the IBM Cognos compression utility.
Installing the IBM Cognos compression utility

The IBM Cognos compression utility is required for data compression on a SAP server. The corresponding decompression function is included in the SAP gateway functions.

You must install the compression utility on each SAP server that you want to use with IBM Cognos Data Manager.

If you have installed the IBM Cognos compression utility with IBM Cognos DecisionStream version 7, you do not have to reinstall the utility. The utility included in this installation is the same as was used in version 7.

Installing the IBM Cognos compression on Windows

This topic describes how to install the compression utility on a SAP server running on a Microsoft Windows operating system.

Procedure

1. Go to the \c10_location\bin directory, and locate the files named udacompr.exe and zlib*.dll.
2. Copy these files to the DIR_EXECUTABLE directory and the DIR_CT_RUN directory on all Windows SAP servers.
   - The DIR_EXECUTABLE directory is usually defined as SAP_instance\SYS\exe\run, and the DIR_CT_RUN directory is usually defined as SAP_instance\SYS\exe\uc\NTAMD64.

Installing the Cognos compression on UNIX

This topic describes how to install the compression utility on a SAP server running on a UNIX operating system.

There are two methods described. Both have the same result, so the method that you select depends on your personal preference.

Installing Cognos compression on UNIX method 1:

This topic describes the first method that you can use to install the compression utility on a SAP server running on a UNIX operating system.

Procedure

1. From the zipfiles/operating_system directory on the IBM Cognos Data Manager Connector for SAP R/3 CD, use binary transfer mode to FTP the following files to a temporary directory on all SAP servers.
   - udasapr3<operating_system>-app<version>-inst.tar.gz
     - This file also contains the SAP transport files described in “Applying the SAP gateway functions” on page 26 and “Applying the SAP gateway functions” on page 26.
   - zlibbin<operating_system>-gate<version>-inst.tar.gz
2. Run gunzip on both files to uncompress them to .tar files.
3. Run tar -xvf on both files to extract the contents of the .tar file.
4. The bin sub-directory should contain, udacompr, libz.* files and possibly some other files. Copy all the files from the bin sub-directory to the DIR_EXECUTABLE directory and the DIR_CT_RUN directory.
   - These directories are usually defined as SAP_instance/SAP/exe/run/.
5. Set execute privileges for all the files.
Installing the Cognos compression on UNIX method 2:

This topic describes the alternative method that you can use to install the compression utility on a SAP server running on a UNIX operating system.

Procedure

1. From the zip files/operating_system directory on the Cognos IBM Data Manager Connector for SAP R/3 CD, unzip the following files to a temporary directory on Windows:
   - udasapr3<operating_system>-app<version>-inst.tar.gz
   - zlibbin<operating_system>-gate<version>-inst.tar.gz

2. Using binary transfer mode, FTP all the files in the bin sub-directory to the DIR_EXECUTABLE directory and DIR_CT_RUN on all SAP servers.
   These directories are usually defined as SAP_instance/SAP/exe/run.

3. Set execute privileges for all the files.

Setting access permissions for the SAP gateway functions

For the SAP gateway functions to access SAP data, you must assign specific permissions to the user accounts that connect to the SAP server.

Before you begin

Before importing new tables from SAP, check that your administrator has added the authorization group to the authorization object S_TABU_DIS in table TDDAT. If this access is not granted, you cannot access the data in the tables.

Procedure

1. Ensure that the SAP user accounts that use the SAP connector have the following privileges:
   - S_RFC, for the authorization check for RFC access
   - S_DATASET, for the authorization check for file access
   - S_BTCH_JOB, for background processing
   - S_TABU_DIS, for access to data in the tables

   Incorrect privileges may result in run-time errors, such as the following:
   1. ERROR DS-DBMS-E400: UDA driver reported the following on connection 'ALIAS_01F1A4DC': DMS-E-SAP_CONNECTION_FAILURE, Connection to SAP failed: User UDAQC4 has no RFC authorization for function group Z70F.

2. You must also ensure that the SAP accounts have the required additional permissions to import data.

   Table 4. Additional permissions required to import data

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>Activity</td>
<td>16 - Execute</td>
</tr>
<tr>
<td>S_DATASET</td>
<td>Activity</td>
<td>06 - Delete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>33 - Read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>34 - Write</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A7 - Write with filter</td>
</tr>
<tr>
<td></td>
<td>Physical file name</td>
<td>*</td>
</tr>
</tbody>
</table>
You can use the asterisk (*) to represent all values, when it appears alone, or partial values, when used anywhere in a string.

### Uninstalling Cognos Data Manager

For a Microsoft Windows operating system, you should use the uninstallation program to remove all IBM Cognos program files.

The uninstallation program does not remove configuration and user data files or all the directories. You can manually remove remaining directories after the uninstallation program finishes.

**Before you begin**

Before you uninstall IBM Cognos Data Manager on a UNIX or Linux operating system, ensure that you back up any data that you added to the installation directory.

### Uninstalling Cognos Data Manager on Windows

This topic describes how to uninstall IBM Cognos Data Manager on a Microsoft Windows operating system.

**Procedure**

1. From the Start menu, click Programs, IBM Cognos 10, Uninstall IBM Cognos, Uninstall IBM Cognos.
   The Uninstall wizard appears.
2. Select the language of the installation.
3. Select the components that you want to uninstall.
   Log messages are written to a cognos_uninst_log.txt file that is created in your system Temp directory.

### Uninstalling Cognos Data Manager on UNIX or Linux

This topic describes how to uninstall IBM Cognos Data Manager on a UNIX or Linux operating system.

**Procedure**

1. Stop the IBM Cognos process:
   - If you use XWindows, start IBM Cognos Configuration, and from the Actions menu, click Stop.
   - If you do not use XWindows, go to the c10_location/bin directory, and type ./cogconfig.sh -stop
2. Go to the c10_location/uninstall directory and type the appropriate command:
• If you use XWindows, type "./uninst -u" If you do not use XWindows, do a silent uninstallation by typing "./uninst -u -s"
3. Follow the instructions to complete the uninstallation.
Chapter 6. Configuring Cognos Data Manager

You can use IBM Cognos Data Manager with the default configuration values.

Additional configuration is required in the following circumstances:
- You have installed Cognos Data Manager components on different computers.
- You want to use an application server for IBM Cognos Data Manager Network Services other than one provided with the installation.
- You are installing into an environment with other IBM Cognos Business Intelligence components.
- You want to use SSL for Cognos Data Manager Network Services.

If you have installed Cognos Data Manager Network Services or intend to use Cognos Data Manager with other Cognos BI components, you must save your configuration, even if you are using the default settings. For more information, see “Saving your configuration settings” on page 39.

For information about the properties that you can configure for IBM Cognos components, see the IBM Cognos Configuration User Guide.

For information about SSL, see “Configuring Secure Sockets Layer for Cognos components” on page 41.

Java settings

To support the cryptographic services in IBM Cognos Business Intelligence, you may be required to update your version of Java or set a JAVA_HOME environment variable. Depending on your security policy requirements, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

You can use an existing Java Runtime Environment (JRE) or the JRE that is provided with IBM Cognos BI.

**JAVA_HOME**

If you want to use your own JRE and have JAVA_HOME set to that location on Microsoft Windows operating system or if you are installing on a UNIX or Linux operating system, you must update JAVA_HOME for the cryptographic services.

On Windows, you can set JAVA_HOME as a system variable or a user variable. If you set it as a system variable, it may be necessary to restart your computer for it to take effect. If you set it as a user variable, set it so that the environment in which Tomcat (or other application server) is running can access it.

If you do not have a JAVA_HOME variable already set on Windows, the JRE files provided with the installation will be used, and you do not have to update any files in your environment. If JAVA_HOME points to a Java version that is not valid for Cognos BI, you must update JAVA_HOME with the path to a valid Java version.

If you do not have a JAVA_HOME variable already set on Windows, the JRE files provided with the installation are used, and you do not have to update any files in
your environment. If JAVA_HOME points to a Java version that is not valid for
Cognos BI, you must update JAVA_HOME with the path to a valid Java version.

You must ensure that the Java Runtime Environment version is appropriate for
IBM Cognos Configuration. For example, for a Microsoft Windows operating
system, use either a 32-bit or 64-bit version of JRE, depending on the IBM Cognos
BI component installed. For UNIX and Linux operating systems, you must use a 64
bit version of JRE.

**Unrestricted JCE Policy File**

Whether you use the default Windows JRE or download a JRE for UNIX or Linux,
the JRE includes a restricted policy file that limits you to certain cryptographic
algorithms and cipher suites. If your security policy requires a wider range of
cryptographic algorithms and cipher suites than are shown in IBM Cognos
Configuration, you can download and install the unrestricted JCE policy file.

**Update your Java environment**

If you do not have a JAVA_HOME variable already set on a Microsoft Windows
operating system, the JRE files provided with your product will be used to
generate the cryptographic keys needed to communicate with the IBM Cognos
servers.

If you want to use another JRE and have JAVA_HOME set to that location, the JRE
files from that location will be used.

The JRE that is provided with your product includes a restricted policy file that
limits you to certain cryptographic algorithms and cipher suites. If your security
policy requires a wider range of cryptographic algorithms and cipher suites than
are shown in IBM Cognos Configuration, you can download and install the
unrestricted JCE policy file.

**Procedure**

1. Ensure that the JAVA_HOME environment variable is set to the JRE location.
   For example, to set JAVA_HOME to a JRE that you are already using, the path
   is Java_location/bin/jre/version.
2. If your security policy requires it, download and install the unrestricted JCE
   policy file.
   For Java that is provided by IBM, the unrestricted JCE policy file is available on
   the IBM website (https://www14.software.ibm.com/webapp/iwm/web/
   preLogin.do?source=jcesdk).

**Starting Cognos Configuration**

You use IBM Cognos Configuration to set the location and port number for the
IBM Cognos Data Manager Network Services server, to set the protocol that you
want to use for remote communication between IBM Cognos Data Manager
Designer and the IBM Cognos Data Manager engine, and to set log file locations.

You can also start and stop the services using IBM Cognos Configuration. For
information on starting and stopping services, see “Starting or stopping the
Cognos Service” on page 40.
If your UNIX or Linux operating system environment does not support a Java-based graphical user interface, you must configure your components by editing the cogstartup.xml file located in the $c10_location/configuration directory. After you edit the file, you can run Cognos Configuration in silent mode to apply the configuration. For more information, see Appendix A, “Configuring Cognos Data Manager on UNIX or Linux without a graphical interface,” on page 61 or the IBM Cognos Configuration User Guide.

Alternatively, you can start Cognos Configuration from the last page of the Installation wizard.

Cognos Configuration uses cryptography to securely store access passwords, such as the service access password for the Cognos Data Manager Network Services Socket server. Any access password you enter into Cognos Configuration is stored in unencrypted form until you save your configuration settings.

Starting Cognos Configuration on Windows
This topic describes how to start IBM Cognos Configuration on a Microsoft Windows operating system.

**Procedure**

From the **Start** menu, click Programs, IBM Cognos 10, IBM Cognos Configuration.

Starting Cognos Configuration on UNIX or Linux
This topic describes how to start IBM Cognos Configuration on a UNIX or Linux operating system.

**Procedure**

Go to the $c10_location/bin directory and type the appropriate command:
If you use XWindows, type
./cogconfig.sh
If you do not use XWindows, type
./cogconfig.sh -s

Default Settings for Cognos Data Manager
The following table lists the default ports and URI settings for IBM Cognos Data Manager. After installation, you can use IBM Cognos Configuration to change the settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway URI</td>
<td>The URI to the IBM Cognos Business Intelligence gateway.</td>
</tr>
<tr>
<td></td>
<td>Default: <a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a></td>
</tr>
<tr>
<td>Dispatcher URI for external applications</td>
<td>The URI to the Cognos BI dispatcher. Default: <a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
</tr>
</tbody>
</table>
### Table 5. Cognos Data Manager default ports and URI settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos Data Manager SOAP Server URI</td>
<td>The URI for the Cognos Data Manager SOAP server.</td>
</tr>
<tr>
<td></td>
<td>Default: <a href="http://localhost:9300/axis">http://localhost:9300/axis</a></td>
</tr>
<tr>
<td>Cognos Data Movement Service Enabled?</td>
<td>Enables the Cognos Data Movement Service.</td>
</tr>
<tr>
<td></td>
<td>Default: True</td>
</tr>
<tr>
<td>Shutdown port number</td>
<td>The shutdown port number for the IBM Cognos service, including the Cognos Data Manager SOAP server service.</td>
</tr>
<tr>
<td></td>
<td>Default: 9399</td>
</tr>
<tr>
<td>Socket port number</td>
<td>The socket server port number.</td>
</tr>
<tr>
<td></td>
<td>Default: 9310</td>
</tr>
</tbody>
</table>

### Updating data and log file locations for Windows Vista

If you install IBM Cognos Data Manager on a Microsoft Windows Vista operating system, you must change file locations properties in IBM Cognos Configuration so that Cognos Data Manager can use a single data location for all users.

Windows Vista has a security enhancement that restricts multiple users from sharing data locations. You can define environment variables and use them in Cognos Configuration when specifying file locations. This allows you to direct applicable files to an area that will be accessible by users. On Windows, two environment variables are preset for users: one for all users and one for the specific user.

Because the environment variables represent system root locations, we recommend that you also include the root directory name of the installation location when you specify file locations in Cognos Configuration. The default root directory for IBM Cognos Business Intelligence applications is c10.

#### Procedure

1. In the **IBM Cognos Configuration**, expand **Environment**, and click **Data Manager**.

2. In the **Value** box for the data and log file locations, replace the relative path element, ". ..", with the appropriate environment variable and root directory, using the following suggested environment variables:
   - For a single file location per user, %LOCALAPPDATA%
   - For a single file location for all users on the computer, %PUBLIC%

For example, to set a single file location per user, specify the path %LOCALAPPDATA%/c10/

**Warning**: You must set up a valid location. If the location does not exist, Cognos Data Manager cannot write data and log files.

3. Repeat step 2 for the following property, if required:
   - Under **Environment, Data Manager Network Services** - Log files location.

4. Click **File, >, Save**.
Results

The environment variables are resolved when the file locations are accessed during system activities.

Configuring Cognos Data Manager Network Services

You use IBM Cognos Configuration to set port numbers and network protocols for IBM Cognos Data Manager Network Services.

If you installed all components on the same computer, such as in a test environment, the default settings may be appropriate.

The Cognos Data Manager Network Services server can use different network protocols for communication with IBM Cognos Data Manager Designer. You can choose the protocol and set the port numbers. You can also set logging options for the server.

Changing the socket server port number and password

If the default socket port number conflicts with another port number in your environment, you can change it. Do not use port numbers that are reserved, well-known, or registered.

The Socket protocol requires a password to ensure that connections are coming from an authorized source. If you change the password, you must also change the password for all IBM Cognos Data Manager clients that contact the server. The passwords must be the same as the password on the server. For more information see, "Configuring Cognos Data Manager clients to locate the Network Services server" on page 36.

Procedure

1. In IBM Cognos Configuration, Data Manager > Data Manager Network Services > Server, click Socket Server.
2. If you want to change the default password, type a password in Service Access Password.
   
   Note: If you change this password, you must also change this password for all Cognos Data Manager Network Service clients. The passwords must be the same.
3. If you want to change the socket port number, type a port number value in Socket Port Number.

Changing the SOAP or secure SOAP server port number

If the default SOAP server port number conflicts with another port number in your environment, you can change it to any open port number.

The port number you use depends on your how you distributed IBM Cognos Data Manager components during installation:

- Same location on the same computer as IBM Cognos Business Intelligence.
- If you installed other Cognos BI components to the same location on your computer, the port number must be the same as the External Dispatcher URI for the Cognos BI dispatcher. You must also ensure that the protocol, such as http or https, is the same.
• Different location on the same computer as Cognos BI.

If you installed Cognos Data Manager on the same computer as other Cognos BI components but to a different location, the port number for it must be different from the port number for the Cognos BI dispatcher. You must also ensure that you change the shutdown port number as well.

• Multiple instances of Cognos Data Manager on the same computer.

If multiple installations of Cognos Data Manager are on the same computer and are using Cognos Data Manager Network Services, ensure that the application server port numbers, including the application server shutdown port number, are unique for each installation.

Tip: The shutdown port can be set in Environment > IBM Cognos Services > IBM Cognos. The default value is 9399.

Do not change the text after the port number. The URI must be in the form http://hostname:port/axis or https://hostname:port/axis.

Procedure
1. In IBM Cognos Configuration, click Environment.
2. Click the Value box for Data Manager SOAP Server URI, and type a port number.

Setting logging options for the server

The logging severity value determines the amount of messages written to the log files by IBM Cognos Data Manager Network Services.

Procedure
1. In IBM Cognos Configuration, under Environment > Data Manager > Data Manager Network Services > Server, click a server protocol.
2. Enter a value for Logging Severity.

You can enter 1, for the lowest, to 5, for the highest. The default is 3.

Configuring Cognos Data Manager clients to locate the Network Services server

For IBM Cognos Data Manager Designer or the command line utilities to communicate with the IBM Cognos Data Manager engine on a remote computer, you must set the correct host name, port number, protocol, and service access password for the IBM Cognos Data Manager Network Services server.

Procedure
1. In IBM Cognos Configuration, under Environment > Data Manager > Data Manager Network Services > Client, click a connection.

The default connection name is localhost. You can use localhost if you have installed the Cognos Data Manager engine on the same computer as Cognos Data Manager Designer. If you have installed Cognos Data Manager Designer on another computer, see “Adding connections for additional Cognos Data Manager engines” on page 37.

2. Click the Value box for Protocol for Remote Connections, and select the appropriate protocol.

Secure SOAP uses the secure protocol (https) for communication, whereas SOAP uses the standard protocol (http). Socket uses a direct connection.
3. In the Port box, enter the port number for the server.

4. If the default password was changed, enter the **Service Access Password**.
   This password is used by the Socket connection to ensure secure transactions.
   If you use SOAP or Secure SOAP, you must still ensure that the **Service Access Password** matches the password set for the Socket server.

   **Note:** If you click **Environment > Data Manager > Data Manager Network Services > Client**, some default properties are displayed. These values define a connection to a Cognos Data Manager Network Services server on the same computer. The host value is localhost, and cannot be changed. During the installation, a connection is added for the computer on which you installed Cognos Data Manager; that is localhost. If you want to change the port number on which the server is running, you can change the value for the localhost connection. You do not have to change the default value.

**Setting logging options for the client**

The logging severity value determines the amount of messages written to the log files by IBM Cognos Data Manager Network Services.

**Procedure**

1. In IBM Cognos Configuration, expand **Environment > Data Manager > Data Manager Network Services**, click **Client**.
2. Enter a value for **Logging Severity**.
   You can enter 1, for the lowest, to 5, for the highest. The default is 3.

**Adding connections for additional Cognos Data Manager engines**

If your environment was set up with several installations of the IBM Cognos Data Manager engine with IBM Cognos Data Manager Network Services, you can add a connection for each Cognos Data Manager engine to your IBM Cognos Data Manager Design environment computer.

**Procedure**

1. In IBM Cognos Configuration, click **Environment > Data Manager > Data Manager Network Services > Client**.
2. Click **Edit > New Resource > Data Manager Net Connection**.
3. In the **Name** box, type the name of the computer on which the Cognos Data Manager engine has been installed, and click **OK**.
   The **Name** value must match the name of the computer on which the Cognos Data Manager engine and the Cognos Data Manager Network Services server have been installed.
   The settings for the connection are shown in Cognos Configuration.
4. Click the **Value** box for **Protocol for Remote Connections**, and select the appropriate protocol.
   **Secure SOAP** uses the secure protocol (https) for communication, whereas **SOAP** uses the standard protocol (http). **Socket** uses a direct connection.
5. In the **Port** box, enter the port number for the server.
6. Enter the **Service Access Password**.
   This password is used by the Socket connection to ensure secure transactions.
   If you add a connection, you must change the default **Service Access Password**. Ensure that you enter the same value that was set for the Socket
Setting data and log file locations

You use IBM Cognos Configuration if you want to change the data and log file locations for IBM Cognos Data Manager Network Services.

If you are installing Cognos Data Manager Network Services on a Microsoft Windows Vista operating system, you must change file locations properties in Cognos Configuration so that Cognos Data Manager Network Services can use a single data location for all users. For more information, see "Updating data and log file locations for Windows Vista" on page 34.

Procedure

1. In Cognos Configuration, expand Environment, and click Data Manager.
2. Click the Value box, and select a location for the data and log files.
3. In the Explorer window, click Data Manager Network Services.
4. Click the Value box, and select a location for the network services log files.

Enabling or disabling Cognos Data Manager services

You can prevent IBM Cognos Data Manager Network Services or the IBM Cognos Data Movement Service from being started when you start the IBM Cognos service.

If you disable the Cognos Data Manager Network Services service, you cannot submit remote jobs from IBM Cognos Data Manager Designer or by using the command line or scripts. If you have installed the IBM Cognos Data Manager engine into the same location as an IBM Cognos Business Intelligence server, disabling the Cognos Data Movement Service will prevent users from running or scheduling builds from IBM Cognos Connection. It will also prevent Cognos Data Manager Designer users from executing builds using the CognosData Movement Service.

However, Cognos Data Manager Designer users will still be able to submit jobs to the local Cognos Data Manager engine and use the command line.

Procedure

1. On the computer where you installed Cognos Data Manager Network Services server, start Cognos Configuration.
2. In the Explorer window, click Environment > IBM Cognos services.
3. In the Properties window, click the Value box next to Data Manager SOAP Service Enabled, and do one of the following:
   • To disable the service, click False.
   • To enable the service, click True.
4. In the Properties window, click the Value box next to Data Movement Service Enabled, and do one of the following:
   • To disable the service, click False.
   • To enable the service, click True.
IBM Cognos Data Manager can access data sources used by other IBM Cognos Business Intelligence components. If you want to access these data sources, you must configure the Cognos Business Intelligence gateway and dispatcher on all computers where Cognos Data Manager components are installed.

To use the IBM Cognos Data Movement Service to run and schedule builds and JobStreams, either from Cognos Data Manager Designer or using IBM Cognos Connection, you must set the Cognos BI gateway.

If you installed Cognos Data Manager in the same location as Cognos BI, the default settings may be appropriate. The protocol and port number for the External dispatcher URI for Cognos BI and the Data Manager SOAP Server URI must be the same. For example, if the External dispatcher URI is http://localhost:9310/p2pd/servlet/dispatch, then the Data Manager SOAP Server URI must be http://localhost:9310/axis.

If Cognos Data Manager is installed on another computer or to another location on the same computer as Cognos BI, the Dispatcher URI for external applications must point to the Cognos BI dispatcher and use the same protocol, but the Data Manager SOAP Server URI does not have to use the same protocol.

**Procedure**

1. In IBM Cognos Configuration, click Environment.
2. Click the Value box for Gateway URI, and type the location for the Cognos BI gateway.
   
   For example, if you want to use the Data Movement Service, the Cognos Data Manager engine must be installed in the same location as an IBM Cognos BI server. The Gateway URI must point to the Cognos BI gateway location. The Cognos BI gateway may be on a different computer than the Cognos BI server and the Cognos Data Manager engine.
3. Click the Value box for Dispatcher URI for external applications, and type the location for the Cognos BI dispatcher.

**Saving your configuration settings**

After you specify the values for the mandatory configuration properties, or make any changes to local property values, you must save the configuration.

When you save the configuration, passwords are encrypted and a certificate is issued to validate the identity of the IBM Cognos computer. You can save the configuration in the default encoding of your computer or in UTF-8 encoding.

Each time you save your configuration, the changes are stored in the cogstartup.xml and coglocale.xml files in the c10_location/configuration directory. At the same time, a backup copy of these files, containing the previous configuration settings, is created with a date and time stamp in the c10_location/configuration directory.

**Procedure**

1. From the File menu, choose which encoding to use to save the configuration:
If you use more than one language or character set in the configuration settings, click **Save As UTF-8**.

If you use the default encoding of your computer, click **Save**.

Errors, such as missing values for mandatory properties, cause an error message to appear. To view the cause of the error, click the **Details** box.

**Important:** You must restart the IBM Cognos service before the saved configuration values are applied to your computer.

2. If you plan to use the local configuration as a template for configuring other computers that have the same installed IBM Cognos components, export the configuration. For information, see the *IBM Cognos Configuration User Guide*.

---

### Starting or stopping the Cognos Service

You use IBM Cognos Configuration to start and stop all IBM Cognos services, including the Cognos service. If you installed other IBM Cognos components, they can all be started at the same time.

Before you can use IBM Cognos Data Manager Network Services or the IBM Cognos Data Movement Service, you must start the Cognos service.

**Procedure**

- From the **Actions** menu, click **Start** or **Stop**.

---

### Starting or stopping the Cognos Data Manager Network Services server

You use IBM Cognos Configuration to start and stop all IBM Cognos services, including the IBM Cognos Data Manager Network Services SOAP service. If you installed other IBM Cognos components, they can all be started at the same time.

Before you can use the Cognos Data Manager Network Services SOAP service or the Cognos Data Movement Service, you must start the Cognos service.

If you use only the Socket protocol, you can start this service without starting all other Cognos services. You can also prevent the SOAP server from starting by disabling the service. For more information, see “Enabling or disabling Cognos Data Manager services” on page 38.

If you use the SOAP server, you must still start the Socket service.

### Starting or stopping the socket server

This topic describes how to start or stop the socket server.

**Procedure**

1. In IBM Cognos Configuration, under **Environment > Data Manager, Data Manager Network Services > Server**, click **Socket Server**.
2. From the **Actions** > **Start** or **Stop**.

### Starting or stopping the SOAP server

This topic describes how to start or stop the SOAP server.
Procedure
1. In IBM Cognos Configuration, under Environment > IBM Cognos Services, click IBM Cognos.
2. Click Actions > Start or Stop.
   If you have other IBM Cognos components installed on the same computer, all components are started or stopped.

Starting or stopping services on UNIX or Linux without a Java-based Interface
This topic describes how to start or stop IBM Cognos services on a UNIX or Linux operating system without a Java-based interface.

Procedure
1. Go to the c10_location/bin directory.
2. Choose whether to start or stop the service:
   • To start the services, type ./cogconfig.sh -s
   • To stop the services, type ./cogconfig.sh -stop

For more information, see Appendix A, “Configuring Cognos Data Manager on UNIX or Linux without a graphical interface,” on page 61.

Configuring Secure Sockets Layer for Cognos components
The Secure Sockets Layer (SSL) protocol can be used to provide secure communication for IBM Cognos Data Manager Network Services.

To configure the SSL protocol, complete the following tasks:
• Configure IBM Cognos Data Manager for standard, non-SSL protocol, and save the configuration.
• Stop the services.
• Configure Cognos Data Manager for SSL.
• Set up shared trust between IBM Cognos components installed on different computers.
• Start the services.

After configuring the SSL protocol, you can select and rank cipher suites, which control the quality of protection used in the SSL connection.

For more information about configuring SSL when you have other IBM Cognos components installed, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

Configuring Cognos Data Manager for Secure Socket Layer
You can configure IBM Cognos components to use the Secure Socket Layer (SSL) protocol for connections between IBM Cognos Data Manager Network Services clients and Cognos Data Manager Network Services servers.

In a single computer, single location installation, such as in a test environment, you must stop the service before adding SSL to your configuration. After you save the configuration with SSL settings, you can restart the service.
In distributed installations, such as IBM Cognos Data Manager components on different computers or different locations on the same computer, you must first configure all Cognos computers to use the non-secure (http) protocol and save the configuration before you can configure the components for SSL.

After you configure all computers in the distributed installation to use the default, non-secure protocol, we recommend that you test your installation to ensure that Cognos components are working properly. After you test your installation, you can configure the SSL protocol.

If other Cognos components are installed to the same location, the Cognos Data Manager SOAP Server URI must use the same protocol as the External dispatcher URI. Consider the following examples:

- If IBM Cognos Business Intelligence is configured to use SSL only for internal connections, the Internal dispatcher URI property is set to https and the External dispatcher URI property is set to http. The Data Manager SOAP Server URI should be set to http.
- If Cognos BI is configured to use SSL only for external connections, the Internal dispatcher URI property is set to http and the External dispatcher URI property is set to https. The Data Manager SOAP Server URI should be set to https.

Note: In these two examples, the port numbers for the two dispatcher URIs are different. If the components are installed to the same location, the Data Manager SOAP Server URI must use the same port number as well as the same protocol as the External dispatcher URI.

- If Cognos BI is configured for SSL for all connections, the URIs for both the Internal dispatcher URI and External dispatcher URI properties are set to https. The Data Manager SOAP Server URI must also be set to https.

Note: If you have other IBM Cognos components installed, see the IBM Cognos Business Intelligence Installation and Configuration Guide for more information about configuring SSL.

The following steps must be performed for all installations to use SSL.

**Configuring Cognos Data Manager for Secure Socket Layer for the Cognos Data Manager Network Services server**

This topic describes how to configure a IBM Cognos Data Manager Network Services server to use the Secure Socket Layer (SSL) protocol.

**Procedure**

1. Start IBM Cognos Configuration on the Cognos Data Manager Network Services server computer.
2. In the Explorer window, click Environment.
3. In the Properties window, type https in the Data Manager SOAP Server URI instead of http.
   - If you have only Cognos Data Manager installed, you do not have to change the port number.
4. From the File menu, click Save.

**Configuring Cognos Data Manager for Secure Socket Layer for a Cognos Data Manager Network Services Client**

This topic describes how to configure an IBM Cognos Data Manager Network Services client to use the Secure Socket Layer (SSL) protocol.
**Procedure**

1. Start IBM Cognos Configuration on the Cognos Data Manager Network Services client computer.
2. In the Explorer window, under Environment > Data Manager > Data Manager Network Services > Client > Connection.
3. Click the Value box for Protocol for Remote Connection, and click Secure SOAP.
4. From the File menu, click Save.

**Setting up shared trust between Cognos Data Manager Network Services client and server**

Setting up shared trust allows the components that are using the Secure SOAP (https) protocol to use compatible encryption and decryption keys for secure transactions.

In some cases the shared trust is set up automatically when you save your configuration. In others cases, you may be required to manually transfer security certificates between computers.

If you use IBM Cognos Data Manager with other IBM Cognos Business Intelligence components, and both the Cognos Data Manager Network Services client and server computer are configured with the Cognos BI gateway URI, then you do not have to manually transfer the certificates. The certificates are automatically retrieved from the gateway. Also, if you have the Cognos Data Manager Network Services client and server installed on the same computer in the same location, such as a test environment, you do not have to manually transfer the security certificates.

You must manually transfer certificate files between computers in the following circumstances:

- You do not use Cognos Data Manager with Cognos BI components and the Cognos Data Manager Network Services server and client are installed on different computers or in different locations on the same computer.
- You use Cognos Data Manager with other Cognos BI components, and either the Cognos Data Manager Network Services server or client is configured with the Cognos BI gateway URI, but not both.

In these cases, you must copy the IBM Cognos certificates generated on the Cognos Data Manager Network Services server computer to all client computers. The certificate is generated when you save the configuration.

If you want the connection between the server and clients to be mutually authenticated, you must also copy the certificates generated when you saved the configuration on the client to the server.

If you configured IBM Cognos components to use another certificate authority (CA), you do not have to manually transfer the security certificates between computers.

**Exporting a certificate**

This topic describes how to export a certificate.
**Procedure**

1. Go to the `c10_location/bin` directory.
2. Export the certificate by typing the following command:

   ```
   On a Microsoft Windows operating system, type
   ThirdPartyCertificateTool.bat -E -T -r certificate_file -k
   c10_location/configuration/signkeypair/jCAKeystore -p password
   ```

   ```
   On a UNIX or Linux operating system, type
   ThirdPartyCertificateTool.sh -E -T -r certificate_file -k
   c10_location/configuration/signkeypair/jCAKeystore -p password
   ```

   You can now import the certificate to the trust store on another computer.

**Importing a certificate**

This topic describes how to import a certificate.

**Procedure**

1. Copy the certificate to a secure location.
2. Import the certificate by typing the following command:

   ```
   On Windows, type
   ThirdPartyCertificateTool.bat -T -i -r certificate_file -k
   c10_location/configuration/signkeypair/jCAKeystore -p password
   ```

   ```
   On UNIX or Linux, type
   ThirdPartyCertificateTool.sh -T -i -r certificate_file -k
   c10_location/configuration/signkeypair/jCAKeystore -p password
   ```

   To set these commands, you must have a JAVA_HOME value set. If your
   JAVA_HOME path includes spaces, you may have to edit the last line of the file
   to include quotation marks around "%J_HOME%\bin\java.exe".

**Select and rank cipher suites for Secure Socket Layer**

An SSL connection begins with a negotiation in which the client and server present
a list of supported cipher suites in a priority sequence. A cipher suite provides
the quality of protection for the connection. It contains cryptographic, authentication,
hash, and key exchange algorithms. The SSL protocol selects the highest priority
suite that the client and the server both support.

A list of supported cipher suites for SSL is provided. You can eliminate cipher
suites that do not meet your requirements and then assign a priority, or preference,
to the remaining cipher suites. The selected cipher suites are presented in priority
sequence for the client and server sides of the negotiation. At least one of the
selected cipher suites between the client and server platforms must match.

The list of supported cipher suites is dynamically generated on each computer, and
depends on the Java Runtime Environment (JRE) or whether you have other
cryptographic software installed on the computer. If you have made changes to a
computer, such as upgraded the JRE or installed software that has upgraded the
JRE, this may affect the supported cipher suites available on that computer. If you
no longer have a supported cipher suite that matches the other computers in your
environment, you may have to change the JRE on the computer to match the other
computers in your environment.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Cryptography > Cognos.
3. In the Properties window, click the Value column for the Supported ciphersuites property.

4. Click the edit icon.
   - To move a cipher suite to the Current values list, click the check box in the Available values list and then click Add.
   - To move a cipher suite up or down in the Current values list, click the check box and then click the up or down arrows.
   - To remove a cipher suite from the Current values list, click the check box and then click Remove.
5. Click OK.
6. From the File menu, click Save.

---

Specifying the encoding to use for log files and reject files

If you are using IBM Cognos Data Manager with multilingual or unicode data, you should specify unicode encoding for your log files and reject files. By default, the encoding used is platform dependent.

**Specifying the encoding to use for log files**

You can specify the encoding by setting an environment variable or by specifying the encoding in the dm.ini file.

**Specifying the encoding using an environment variable**

This topic describes how to specify the encoding using an environment variable.

**Procedure**

1. On a Microsoft Windows operating system, in the System Properties window for your computer, click the Advanced tab, and then Environment Variables.
2. In the System variables box, click New.
3. In the Variable name box, type the following:
   - DS_LOG_ENCODING
4. In the Variable value box type the value for the required encoding. For example UTF-16.
   - You can also set the variable using the command line:
     - On Windows, type
       ```
       SET DS_LOG_ENCODING=encoding_to_use
       ```
     - On a UNIX or Linux operating system, type
       ```
       setenv DS_LOG_ENCODING "encoding_to_use"
       ```

**Specifying the encoding in the dm.ini file**

This topic describes how to specify the encoding in the dm.ini file.

**Procedure**

1. Open the dm.ini file. By default, this file is stored in the directory named `c10_location/datamanager`.
2. In the [Encoding] section, add the encoding to use for the log file. For example, `Log Files=UTF-16`
   - If the Log Files entry is preceded by a semi-colon, you must remove the semi-colon.
Specifying the encoding to use for reject files

This topic describes how to specify the encoding to use for reject files.

You can specify the encoding using one of these methods:
- Set an environment variable.
- Specify the encoding in the dm.ini file.
- Enter a command specifying the encoding to use in the Execute Build or Execute JobStream dialog box.

For information about using the Execute Build or Execute JobStream dialog box, see the IBM Cognos Data Manager User Guide.

Specifying the encoding using an environment variable

This topic describes how to specify the encoding using an environment variable.

Procedure
1. On a Microsoft Windows operating system, in the System Properties window for your computer, click the Advanced tab, and then Environment Variables.
2. In the System variables box, click New.
3. In the Variable name box, type the following:
   DS_REJECT_ENCODING
4. In the Variable value box type the value for the required encoding. For example UTF-16.
   You can also set the variable using the command line:
   - On Windows, type
     SET DS_REJECT_ENCODING=encoding_to_use
   - On UNIX or Linux operating system, type
     setenv DS_REJECT_ENCODING "encoding_to_use"

Specifying the encoding in the dm.ini file

This topic describes how to specify the encoding in the dm.ini file.

Procedure
1. Open the dm.ini file. By default, this file is stored in the directory named c10_location/datamanager.
2. Under the [Encoding] section, add the encoding to use for the reject file. For example,
   Reject Files=UTF-16
   If the Reject Files entry is preceded by a semi-colon, you must remove the semi-colon.
Chapter 7. Change application servers

IBM Cognos Business Intelligence components install and use Tomcat as the application server for running the IBM Cognos Data Manager Network Services SOAP server.

If you do not want to use Tomcat, you can use any of the following application servers:
- IBM WebSphere® Application Server.
- BEA WebLogic Server.

**Isolated JVM instances**

To eliminate potential java class or system resource conflicts, IBM Cognos Business Intelligence must be run in a Java Virtual Machine (JVM) instance isolated from other existing applications. This ensures that Cognos BI does not affect any existing customer applications. Cognos BI must be installed in a JVM instance that is separate from the application server administrative processes to isolate both Cognos BI and the administrative functions of the application server.

An isolated JVM instance can be established by creating one of the following:
- A separate server instance in IBM WebSphere.
- A separate managed server in BEA WebLogic.

For information about changing application servers when you have other Cognos BI components installed, see the *IBM Cognos Business Intelligence Installation and Configuration Guide*.

**Process to change application servers**

To set up IBM Cognos Data Manager to run on your application server, complete the following tasks:
- Ensure that the IBM Cognos components are installed.
- Ensure that the application server is installed and operational on each computer where Cognos components are installed.
  For more information, see your application server documentation.
- Ensure that the application server user account has full access permissions for the IBM Cognos installation.
  For UNIX or Linux operating systems, create a new group named ibmcognos. This group must contain the user that starts the application server and the user that owns the Cognos files. Change the group ownership of the Cognos files to the ibmcognos group and change the file permissions for all Cognos files to GROUP READABLE/WRITABLE/EXECUTABLE. For simplicity, you can also use the application server user account to install and run Cognos components.
- Back up any existing configuration information.
- Set the JAVA_HOME environment variable for your application server.
- Update the application server JRE with Cognos security provider files.
- Configure your Cognos components for your application server.
- Build the application file to deploy to your application server.
• Change start-up scripts for your application server, if necessary.
• Configure the application server, and deploy the application file.

# Backing up existing Cognos information

You must back up existing Cognos information within the working environment prior to changing application servers.

You must do this if IBM Cognos Business Intelligence components are running on an application server (including Tomcat) and you are changing to an application server that ships with its own JVM. You must also back up information if you are changing to another JVM vendor.

## Before you begin

Before configuring Cognos BI components to run on the new application server or JVM, you must back up the configuration information and the cryptographic keys. To ensure the security and integrity of your Cognos data, perform the backups to a directory that is protected from unauthorized or inappropriate access.

• Configuration information by exporting it.
  Any encrypted data is decrypted during the export.
• Cryptographic keys by saving them to an alternative location.
  New cryptographic keys must be created using the same JVM that the application server uses. Because these keys can be created only if the previous keys are deleted, it is important to back up the previous keys.

**Tip:** To check if any cryptographic keys exist, look in the `c10_location/configuration` directory. Cryptographic keys exist if this directory includes the subdirectories encryptkeypair and signkeypair. If you have other Cognos BI components installed, you may also have a csk directory.

## Procedure

1. In IBM Cognos Configuration, from the File menu, click **Export As** and save the configuration information in a decrypted format.
   When naming the file, use a name such as decrypted.xml.
2. Stop the IBM Cognos service:
   • If you use Tomcat, stop the Cognos service and close Cognos Configuration.
   • If you use an application server other than Tomcat, shut down Cognos BI in your environment.
3. Back up any existing cryptographic keys by saving the appropriate files and directories to an alternative location that is secure.
   The files are as follows:
   • `c10_location/configuration/cogstartup.xml`
   • `c10_location/configuration/caSerial`
   • `c10_location/configuration/cogconfig.prefs`
   • `c10_location/configuration/coglocale.xml`
   The directories are as follows:
   • `c10_location/configuration/encryptkeypair`
   • `c10_location/configuration/signkeypair`
   • `c10_location/configuration/csk` (if it exists in your installation)
4. Delete the caSerial and cogconfig.prefs files and the directories encryptkeypair, signkeypair, and csk, if it exists.

5. Replace the $c10_location/configuration/cogstartup.xml file with the file that contains the data exported from Cognos Configuration, such as decrypted.xml.

**Important:** In the $c10_location/configuration directory, rename the file to cogstartup.xml

The information in this file is automatically re-encrypted using new cryptographic keys when you save the configuration in Cognos Configuration.

### Setting environment variables

You must set environment variables to identify the location of the JVM environment and the library path.

For information about editing an application server startup script, see [“Changing the application server startup script” on page 51](#).

On a Microsoft Windows operating system, set a system or user variable or edit the application server startup or environment script. If you set a user variable, ensure that you set it for the user account that runs the application server or the administration console.

On UNIX and Linux operating systems, set an environment variable in the user profile or edit the application server startup or environment script.

**Tip:** Most application servers provide a script for setting environment variables. For example, some WebSphere versions include a command named setupCmdLine.bat or setupCmdLine.sh and WebLogic includes setEnv.cmd or setEnv.sh. You can modify these scripts to set the appropriate values for use with IBM Cognos components. Most of these scripts set the JAVA_HOME environment variable by default.

### Procedure

1. Set the JAVA_HOME environment variable to point to the JVM used by the application server.

   **Tip:** If the application server provides a JVM, set the JAVA_HOME environment variable to reference it.

   IBM Cognos Configuration uses this variable to create encryption keys for IBM Cognos components that are compatible with the JVM used by the application server.

   For example, for WebLogic installed on Windows, the JVM used by the application server is specified as `drive:/WebLogic_location/jdk142_04`

2. Append $c10_location/bin to the appropriate environment variable.

   This variable is used to locate the IBM Cognos library files.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>PATH</td>
</tr>
<tr>
<td>AIX</td>
<td>AIX</td>
</tr>
<tr>
<td>AIX</td>
<td>LIBPATH</td>
</tr>
</tbody>
</table>
Table 6. The environment variable for each operating system (continued)

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris</td>
<td>LD_LIBRARY_PATH</td>
</tr>
<tr>
<td>HPUX</td>
<td>SHLIB_PATH</td>
</tr>
</tbody>
</table>

**Tip:** To install multiple instances of IBM Cognos Business Intelligence on a single server, set the PATH, LIBPATH, LD_LIBRARY_PATH, or SHLIB_PATH variable within the application server instance scope and not as a global variable to ensure that each instance has a unique value.

**Configuring Cognos components for your application server**

IBM Cognos Business Intelligence must be configured with the application server configuration information, and the configuration must be saved to create new cryptographic keys.

IBM Cognos Configuration uses the JVM that is defined by the JAVA_HOME environment variable to generate the cryptographic keys.

**Procedure**

1. Start Cognos Configuration.
   - If you have existing incompatible encryption keys, you are prompted to automatically generate new ones at this time.

   **Important:** Ensure that the existing keys are backed up to a secure location before proceeding. There is no undo action available after you generate new keys.

2. In the **Explorer** window, click **Environment**.
3. Click the **Value** box for **Data Manager SOAP Server URI**, and set the port number and host name or IP address for the server.
   - The application server must be configured to listen on the host name or IP address entered in the URI. For more information, see your application server documentation.
4. In the **Explorer** window, expand **Environment > IBM Cognos services**.
5. Right-click **IBM Cognos**, and then click **Delete**.
   - The **IBM Cognos service** can only be used if you are using the Tomcat server that is provided with Cognos BI.
6. Complete other required configuration changes.
7. Click **File > Save**.

**Building an application file to deploy to your application server**

You use IBM Cognos Configuration to build the IBM Cognos Data Manager Network Services server application file to deploy to your application server.

You can build an application file only on the computer where the Cognos Data Manager Network Services server is installed.

You can create a Web archive (WAR) file or an Enterprise archive (EAR) file. For information about WAR and EAR files and which is supported by your application server, see the documentation for your application server.
Procedure

1. In Cognos Configuration, click Actions > Build Application Files.
   The Build Application wizard appears.
2. Select Data Manager Network Services, and click Next.
   For information about building application files when you have other IBM
   Cognos Business Intelligence components installed, see the IBM Cognos Business
   Intelligence Installation and Configuration Guide.
3. Select the type of application to build, select the Location where you want the
   file built, and click Next.
   The default file name is dsnet.extension and the file is created in the c10_location
   by default. When you deploy the file, the context root for Cognos Data
   Manager Network Services must be axis.
   You can deploy the application file to your application server. For information
   about deploying applications, see your application server documentation.
   After you deploy the application, and start the process, Cognos Data Manager
   Designer users can access the Cognos Data Manager engine remotely.
   It is not necessary to rebuild or redeploy the archive file when you make
   configuration changes because configuration information is stored externally.

Changing the application server startup script

Some application servers have specific requirements that you must meet before
you can run an IBM Cognos service. Depending on the application server, you may
have to define environment variables, copy files, and add or change code in files.

Before you begin

If you are using BEA WebLogic Server, you must make changes to the application
server startup script to specify JVM settings.

Changing a WebSphere startup script

This topic describes how to change the startup script for the WebSphere
application server.

Procedure

1. Open the startServer.bat or setupCmdLine.bat command file for editing.
   The file is located in the WebSphere/AppServer/bin directory.
2. Append the following line to the JAVA_OPTIONS system property:
   -Ddsnet.dsnapp.type=SOAP_SERVER
   For example,
   SET JAVA_OPTIONS=-Ddsnet.dsnapp.type=SOAP_SERVER
3. Save and close the file.

Changing a WebLogic startup script

This topic describes how to change the startup script for the WebLogic application
server.

Procedure

1. Create a WebLogic Server (WLS) domain for IBM Cognos Business Intelligence.
For WebLogic 7.0, you can use the Domain Configuration wizard to create the WLS domain.
For WebLogic 8.1, you can use the Configuration wizard to create the WLS domain.
For information about creating domains, see the WebLogic documentation.

2. Go to the appropriate directory and open the startWebLogic.sh (UNIX operating system) or startWebLogic.cmd (Microsoft Windows operating system) file in an editor.
   - For WebLogic 7.0, the file is located in the `WebLogic7.0_location/user_projects/domain_name` directory.
   - For WebLogic 8.1, the file is located in the `WebLogic8.1_location/user_projects/domains/domain_name` directory.

The name of the startup script may vary depending on the type of WebLogic installation performed. For example, in a managed server installation, the name of the startup script is startManagedWebLogic.sh (UNIX) or startManagedWebLogic.cmd (Windows).

3. Select the JVM run mode, and set the JAVA_VM value to `-server`.
   For example,
   
   ```
   JAVA_VM=-server
   ```

4. Modify the JAVA_OPTIONS for WebLogic 7.0.x and 8.1.x to include `-Ddsnet.dsnapp.type=SOAP_SERVER`.
   For example,
   
   ```
   JAVA_OPTIONS=-Dweblogic.security.SSL.trustedCAKeyStore=%WL_HOME%/server/lib/cacerts
   -Dorg.xml.sax.driver=org.apache.xerces.parsers.SAXParser
   -Dweblogic.management.discover=false
   -Ddsnet.dsnapp.type=SOAP_SERVER
   ```

   If you are running a single server, append the text to the file startWebLogic.cmd.

5. Set the minimum and maximum memory used by the JVM.
   Typically, the memory is set by adding or changing two JVM parameters: `-Xms` and `-Xmx`. For information about these parameters, see the JVM or application server documentation.

   **Tip:** A minimum of one-quarter of your physical memory, and a maximum of one-half of your physical memory (at least 512 MB) are suggested starting values that you can change to suit your environment.

6. Ensure that the production mode is enabled by setting the STARTMODE value to true.
   For example,
   
   ```
   STARTMODE=true
   ```

7. Save and close the file.

---

**Configuring application server properties and deploying Cognos components**

Certain configuration or deployment steps are required to run IBM Cognos components on other application servers.
Before you begin

To run applications on a WebLogic Server you must define and create a domain. A domain is the basic administration unit for WebLogic Server. To run WebLogic Platform applications, you must create a domain that includes the appropriate WebLogic Platform components.

Normally, you have an administration server and managed servers. WebLogic is designed so that only one WebLogic Server in a domain can run the Administration service. This server is called the Administration Server. All other servers in the domain are managed by the Administration Server and obtain their runtime configuration from it. These servers are called managed servers.

The Administration server is the single point of control for the entire domain and it must be running for you to make changes to the configuration of any of the managed servers running beneath it.

You use the BEA WebLogic Configuration wizard to create a domain and server. When you have finished, you must start the Administration Server and deploy the CognosData Manager Network Services Web application file.

Configuring properties and deploying Cognos components for WebSphere

This topic describes how to configure WebSphere properties and deploy the IBM Cognos components.

Procedure

1. Start the WebSphere Application Server, and then start the WebSphere Administrative Console.
2. Create a server instance into which you want to deploy the IBM Cognos Business Intelligence application.
3. Install a new Enterprise Application using the archive file that contains the IBM Cognos application.
   The context root must be set to axis for Cognos Data Manager Network Services.
4. Set the memory used by the JVM.
   Usually, the memory is set by adding or changing the initial and maximum Java heap size. For information about these parameters, see the JVM or application server documentation.
   Tip: A minimum of one-quarter of your physical memory, and a maximum of one-half of your physical memory (at least 512 MB) are suggested starting values that you can change to suit your environment.
5. Stop and then restart the WebSphere application server instance used for Cognos components.

Configuring properties and deploying Cognos components for WebLogic

This topic describes how to configure WebLogic properties and deploy the IBM Cognos components.
Procedure

1. If you used the expanded directory option when building the application in IBM Cognos Configuration, go to step 2. If you created a WAR file, deploy the application manually:
   - Create a directory in a location that is accessible to the application server, giving the directory the same name as the context root.
     The context root must be set to axis for Data Manager Network Services.
     The following show example directory locations:
     For WebLogic 7.0: `WebLogic_location/user_projects/domain_name`
     For WebLogic 8.1: `WebLogic_location/user_projects/domains/domain_name`
   - From the directory you just created, extract the application WAR file to the WebLogic installation using the following command:
     `WebLogic_location/jdk_version/bin/jar xvf "path_name/application.war"`
     **Important:** A space and then a period are required at the end of the command. In this command, the period does not refer to the current directory.

2. Start the WebLogic Administration Server (and the WebLogic Managed Server, if appropriate) associated with the IBM Cognos domain.

3. In the WebLogic console, configure a new Web application as follows:
   - Set the application name.
     For example, ibmcognos
   - Set the path to the directory where the expanded application files are located.
     For WebLogic 7.0, set the path to `WebLogic_location/user_projects/domain_name/app_directory`.
     For WebLogic 8.1, set the path to `WebLogic_location/user_projects/domains/domain_name/app_directory`.
     To use the custom loader, do not select the application WAR file from `c10_location`. Copy the file to another location first.

4. To prevent WebLogic from checking for updated application files, set the reload period for the Web application to -1. This improves performance.

5. Restart the WebLogic Managed Server associated with the IBM Cognos domain to activate the changes.

6. Start the Administrator Server for the domain you have created.
   This server has the following default ports:
   - For HTTP, the port is 7001.
   - For HTTPS, the port is 7002.

7. Using the WebLogic administrator console, deploy the application file (WAR).
   You must set the context for the web module to axis.

Enabling the secure socket layer

If you use the Secure Socket Layer (SSL) for IBM Cognos components, you must also enable SSL in the application server environment. You then identify the SSL server certificate to Cognos components.

Before you begin

On UNIX or Linux operating systems, ensure that you set a JAVA_HOME environment variable before you use the ThirdPartyCertificateTool.
On Microsoft Windows operating systems, run the tool with `-java:local` to use the JRE that is provided with the installation. For example,

```
ThirdPartyCertificateTool.bat -java:local -T -i -r ...
```

**Procedure**

1. Configure the application server to use SSL.
   - An SSL server certificate is generated by another certificate authority (CA). The certificate of the CA that generated the SSL server certificate is also provided.
   - For more information about configuring the application server to use SSL, refer to the application server documentation. For information about using CA certificates with your application server, see the CA documentation.
2. Copy the CA certificate to the `c10_location/bin` directory and rename the file to `ca.cer`.
   - This file must be Base-64 encoded X.509 format.
3. From the `c10_location/bin` directory:
   - On Microsoft Windows operating system, type:
     
     ```
     ThirdPartyCertificateTool.bat -T -i -r ca.cer -k ../configuration/ signkeypair/jCAKeystore -p NoPassWordSet
     ```
   - On UNIX or Linux operating systems, type:
     
     ```
     ThirdPartyCertificateTool.sh -T -i -r ca.cer -k ../configuration/ signkeypair/jCAKeystore -p NoPassWordSet
     ```

   **Restriction:** Ensure that the user who runs the script has read access to the directory where the certificate is stored and read access to the certificate file. Otherwise, you might see an error similar to the following error message:

   ```
   Exception in thread "main" java.lang.NullPointerException error when you import the certificate.
   ```

   You must type `jCAKeystore` as the name of the CA keystore.
Chapter 8. Setting up an unattended installation and configuration

Set up an unattended installation and configuration to install an identical configuration across several computers on your network.

You can also automate the installation and configuration process by specifying options and settings for users.

Before you begin

Unattended installations require a transfer specification file (ATS). This file provides the installation options that are used by the Installation wizard rather than relying on user input. This file is created each time the Installation wizard is run. If you must install the same components on several computers, you can use the Installation wizard one time, and then use the transfer specification file generated by that installation to perform the same installation on other computers. Transfer specification files are not generated for subsequent unattended installations.

To perform an unattended configuration you have to export configuration settings from another installation, and then use a command to apply the settings to a new installation. You can export the configuration settings from IBM Cognos Configuration.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all other products are installed and configured.

To set up an unattended installation and configuration, do the following:

- Copy the installation files from the CD to the computer where you want to run the installation.
- Configure a transfer specification file to specify installation options.
- Run an unattended installation.
- Export configuration settings from another computer.
- Apply configuration settings to a new installation.

Configuring a transfer specification file

If you have already used the Installation wizard, you can use the transfer specification file created during that installation to run unattended installations on other computers.

If you have not used the Installation wizard to install components, you can use the default transfer specification file, named response.ats, that is available on the CD. You should modify this file for your environment before you use it for an unattended installation.

Using a file generated by an installation on another computer

This topic describes how to configure a transfer specification file by using a file generated by an installation on another computer.
**Procedure**

1. Use the Installation wizard to copy the required components on one computer.
2. Go to the `c10_location/instlog` directory.
3. Locate the response.ats file.
   The Installation wizard creates a response.ats file based on the settings that you selected. You can use this file for other unattended installations.
4. Copy the response.ats file to the computer where you plan to run the unattended installation.
5. On the computer where you plan to run the installation, insert the installation CD and copy the contents to the computer.
6. Using a text editor, open the transfer specification file that you copied.
7. In the License Agreement windows, change the I Agree property to y.
   This action means that you are accepting the license agreement. To read the terms of the license agreement, see the `LA_language_code` and notices files in either of these locations:
   - On the product disk in the root installation directory for the operating system.
   - On the computer from which you copied the response.ats file in the `c10_location/license/product` directory.
8. Save the transfer specification file in the directory where you copied the contents of the installation CD.
9. Repeat steps 1 to 5 on each computer where you plan to run the installation.
   You can now run the unattended installation.

**Using the response.ats file**

This topic describes how to configure a transfer specification file by the response.ats file.

**Procedure**

1. On the computer where you plan to run the installation, insert the installation CD and copy the contents to the computer.
2. Go to the operating system directory, and open the response.ats file in a text editor.
   For example, on a Microsoft Windows operating system, go to the win32 directory.
   Each section in the response.ats file corresponds to a page in the Installation wizard.
3. In the License Agreement dialogs, change the I Agree property to y.
   This action means that you are accepting the license agreement. To read the terms of the license agreement, see the `LA_language_code` and notices files in the root installation directory for the operating system on the product disk.
4. Select the language by typing 1 next to the language that you want to use.
5. Enter the location where you want IBM Cognos Data Manager installed in the APPDIR value.
   For example, type
   ```
   APPDIR=path_to_install
   ```
   **Tip:** Do not include a space on either side of the equal sign (=).
6. In the **Component List** section, type a 1 next to the components that you want installed.
   - To install all components, set the DS_APP value to 1.
   - To install only the IBM Cognos Data Manager engine, set the DS_ENGINE_APP value to 1.
   - To install only IBM Cognos Data Manager Designer, set the DS_DESIGNER_APP value to 1.
   - To install Cognos Data Manager Network Services, set the DS_NETWORK_APP value to 1.

7. If you are installing on Windows, set the APPFOLDER value to the name of the **Start** menu folder from where you want Cognos Data Manager to be available.

   **Tip:** To ensure that the shortcut folder is visible to all users, set ALLUSERS_FLAG to 1.

8. In the **Install Conditions** section, type a 1 next to each condition that you want to apply.

9. Save the response.ats file to a local directory.
   You can now run the unattended installation.

---

**Running an unattended installation**

You start the unattended installation using the command line.

**Before you begin**

Before you run an unattended installation, ensure that all the system requirements and prerequisites are met and that all other products are installed and configured. Also, ensure that you have access to the installation files from the CD and a modified transfer specification file.

**Procedure**

1. On the computer where you copied the installation files and the response.ats file, open a command window.
2. At a command prompt, go to the operating system directory.
   For example, for a Microsoft Windows operating system, go to the win32 directory.
3. Type the following command, where *file_location* is the directory where you copied the response.ats file:
   
   ```
   isetup -s file_location\response.ats
   ```

---

**Exporting configuration settings from another computer**

To apply configuration settings, you can export configuration settings from another computer that has the same components installed. You use the exported configuration to apply the same configuration to other installations.

**Procedure**

1. In IBM Cognos Configuration, click **File > Export as.**
2. In the **File name** box, type a name for the configuration file.
3. Click **Save.**
Applying configuration settings to a new installation

You import configuration settings using a command line. You cannot import settings using IBM Cognos Configuration.

Procedure

1. Copy the exported configuration file from the source computer or network location to the c10_location/configuration directory on the computer where you want to apply the settings.
2. Rename the file to cogstartup.xml.
3. At a command prompt, go to the c10_location/bin directory.
4. Type the following:
   • On a Microsoft Windows operating system, type
cogconfigw.exe -s
   • On UNIX or Linux operating systems, type
   ./cogconfig.sh -s

   Tip: Log messages are written to the cogconfig_response.csv file in the
c10_location/logs directory.

   You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

   IBM Cognos Configuration applies the configuration settings specified in the cogstartup.xml file, encrypts credentials, generates digital certificates, and, if applicable, starts IBM Cognos services or processes.
Appendix A. Configuring Cognos Data Manager on UNIX or Linux without a graphical interface

If the console attached to your computer running a UNIX or Linux operating system does not support a Java-based graphical user interface, you must follow this process:

- Manually change the default configuration settings by editing the cogstartup.xml file.
- Apply the configuration and the locale settings to your computer by running IBM Cognos Configuration in silent mode.
- If you want to change application servers, you must also build the application file.

If you have other IBM Cognos Business Intelligence components installed, see the IBM Cognos Business Intelligence Installation and Configuration Guide for more information. For more information about using IBM Cognos Configuration, see the IBM Cognos Configuration User Guide.

Manually changing default configuration settings on UNIX or Linux

If the console attached to your computer running a UNIX or Linux operating system does not support a Java-based graphical user interface, you must edit the cogstartup.xml to configure IBM Cognos Business Intelligence to work in your environment.

There are some configuration settings that are not saved in the cogstartup.xml file unless you use the graphical user interface. For example, the server time zone is not set for your IBM Cognos components when you modify the cogstartup.xml file directly and then run IBM Cognos Configuration in silent mode. In this case, other user settings that rely on the server time zone may not operate as expected.

Important: By default, the cogstartup.xml file is encoded using UTF-8. When you save the cogstartup.xml file, ensure that you change the encoding of your user locale to match the encoding used. The encoding of your user locale is set by your environment variables.

When you edit the cogstartup.xml file, remember that XML is case-sensitive. Case is important in all uses of text, including element and attribute labels, elements, and values.

Before you begin

Before you edit the cogstartup.xml file, ensure you perform the following actions:

- Make a backup copy.
- Review the configuration requirements for your installation type.

Procedure

1. Go to the c10_location/configuration directory.
2. Open the cogstartup.xml file in an editor.
3. Find the configuration setting that you want to change by looking at the help and description comments that appear before the start tag of the `<crn:parameter>` elements.

4. Change the value of the `<crn:value>` element to suit your environment.

   **Tip:** Use the `type` attribute to help you determine the data type for the configuration property.

5. Repeat steps 3 to 4 until the configuration values are appropriate for your environment.

   **Note:** Some values in cogstartup.xml, such as passwords, may be encrypted. Encrypted values appear as an alphanumeric string and include `encrypted="true"` in their tag. If you want to change an encrypted value, you must change the value to an unencrypted value and then change `encrypted="true"` to `encrypted="false"`. When you run IBM Cognos Configuration, any values with `encrypted="false"` in their tag are re-encrypted.

6. Save and close the file.

   You should now use a validating XML editor to validate your changes against the rules in the cogstartup.xsd file, located in the `c10_location/configuration` directory.

---

### Starting and stopping Cognos BI in silent mode on UNIX and Linux operating systems

You run IBM Cognos Configuration in silent mode to apply the configuration settings and start the services on UNIX or Linux operating system computers that do not support a Java-based graphical user interface.

Before you run the configuration tool in silent mode, you should ensure the cogstartup.xml file is valid according to the rules defined in the cogstartup.xsd file. The cogstartup.xsd file is located in the `c10_location/configuration` directory.

### Starting Cognos BI in silent mode on UNIX and Linux operating systems

Use the following steps to start the IBM Cognos Business Intelligence software in silent mode.

**Procedure**

1. Ensure that the cogstartup.xml file, located in the `c10_location/configuration` directory, has been modified for your environment.

2. Go to the `c10_location/bin64` directory.

3. Type the following command

   ```
   ./cogconfig.sh -s
   ```

   **Tip:** To view log messages that were generated during an unattended configuration, see the cogconfig_response.csv file in the `c10_location/logs` directory.

**Results**

IBM Cognos Configuration applies the configuration settings specified in the cogstartup.xml file, encrypts credentials, generates digital certificates, and if applicable, starts the Cognos service or process.
Stopping Cognos BI in silent mode on UNIX and Linux operating systems

Use the following steps to stop the IBM Cognos Business Intelligence software in silent mode.

**Procedure**
1. Go to the `c10_location/bin64` directory.
2. Type the following command
   ```bash
cogconfig.sh -stop
   ```

Manually creating an application file to deploy to an application server

If you are deploying IBM CognosData Manager Network Services to another application server, you must create a deployment file. IBM Cognos Business Intelligence provides a Build Application wizard that you can use to create the archive file. If your computer is running a UNIX or Linux operating system does not support a Java-based graphical user interface, you must create the archive file manually.

You can create a Web archive (WAR) file or an Enterprise archive (EAR) file. For information about WAR and EAR files and which is supported by your application server, see the documentation for your application server.

**Creating a WAR File**
This topic describes how to create a WAR file.

**Procedure**
Go to the `c10_location/war/dsnet` directory, and type
```bash
build.sh
```

**Creating an EAR File**
This topic describes how to create an EAR file.

**Procedure**
Go to the `c10_location/war/dsnet` directory, and type
```bash
build.sh ear
```

**Results**
The file is created in the `c10_location` directory. You can deploy this file to your application server.
Appendix B. Database environment variables

If your application uses a relational database or OLAP data source, you must set the database environment variables for the user before you start the IBM Cognos processes.

If you do a default installation, ensure that you set and export the database environment variables before you start installing. IBM Cognos products use these database variables to connect to your database. One option is to include these variables in the .profile or .login script of the user who starts the Cognos services.

Oracle databases

The following table describes the environment variables for Oracle databases and provides example values. Contact your database or network administrator for the correct values for your system.

Table 7. Environment variables for Oracle databases and example values

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORACLE_HOME</td>
<td>The top level directory that contains the database client software or the entire database installation.</td>
</tr>
<tr>
<td></td>
<td>Example: /usr/oracle</td>
</tr>
<tr>
<td></td>
<td>Note: A script may be available to create the environment variables. For more information, see the Oracle documentation.</td>
</tr>
<tr>
<td></td>
<td>Example: /usr/local/bin/coraenv</td>
</tr>
<tr>
<td>TNS_ADMIN</td>
<td>The directory that contains the Oracle file tnsnames.ora, which allows calls to the Oracle database to set the required server connections.</td>
</tr>
<tr>
<td></td>
<td>Example: $ORACLE_HOME/network/admin</td>
</tr>
</tbody>
</table>

Oracle 10G client

The following table describes the environment variables for Oracle 10G clients and provides example values. Contact your database or network administrator for the correct values for your system.
Table 8. Environment variables for Oracle 10G clients and example values

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Solaris: LD_LIBRARY_PATH</td>
<td>The load library path. Some database vendors supply both 32-bit and 64-bit database client libraries. If you are using a 64-bit UNIX operating system, your default load library path probably references the 64-bit client libraries. If you are using the Oracle 9.2 client you must ensure that the 32-bit database client libraries are installed and that the appropriate environment variables are set to enable IBM Cognos products to use the 32-bit database client version. Examples: On Solaris: LD_LIBRARY_PATH=$ORACLE_HOME/lib32:$LD_LIBRARY_PATH On AIX: LIBPATH=$ORACLE_HOME/lib32:$LIBPATH On HP-UX: SHLIB_PATH=$ORACLE_HOME/lib32:$SHLIB_PATH</td>
</tr>
<tr>
<td>NLS_LANG</td>
<td>Oracle's NLS_LANG environment variable and the locale of properties must be IBM Cognos Configuration compatible to avoid unexpected results. NLS_LANG format:language_territory.character_set For example, NLS_LANG French_France.WE8ISO8859P1 On UNIX, a compatible Cognos Configuration Locale settings is Locale fr-fr. On AIX: Native Locale fr_FR.ISO8859-15 On HP-UX: Native Locale fr_FR.iso88591 On Solaris: Native Locale fr Encoding iso-8859-1</td>
</tr>
</tbody>
</table>

Sybase databases

The following table describes the environment variables for Sybase databases and provides example values. Contact your database or network administrator for the correct values for your system.
Table 9. Environment variables for Sybase databases and example values

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYBASE</td>
<td>The top level directory that contains the database client software or the entire database installation. Example: /usr/sybase</td>
</tr>
<tr>
<td>SYBASE_OCS</td>
<td>Open Client (OC/S) installation directory for the version of the client you installed. Examples: OCS-12.5 and OCS-12.0</td>
</tr>
<tr>
<td>On Solaris: LD_LIBRARY_PATH</td>
<td>The load library path.</td>
</tr>
<tr>
<td>On AIX: LIBPATH</td>
<td>You must add the OCS driver to your load library path. Examples:</td>
</tr>
<tr>
<td>On HP-UX: SHLIB_PATH</td>
<td>On Solaris: LD_LIBRARY_PATH=$SYBASE/ $SYBASE_OCS/lib: $LD_LIBRARY_PATH</td>
</tr>
<tr>
<td></td>
<td>On AIX: LIBPATH=$SYBASE/$SYBASE_OCS/lib: $LIBPATH</td>
</tr>
<tr>
<td></td>
<td>On HP-UX: SHLIB_PATH=$SYBASE/$SYBASE_OCS/lib: $SHLIB_PATH</td>
</tr>
<tr>
<td>DSQUERY</td>
<td>The default database server connection. Example: mySybaseInstance</td>
</tr>
</tbody>
</table>

Informix® databases

The following table describes the environment variables for Informix databases and provides example values. Contact your database or network administrator for the correct values for your system.

Table 10. Environment variables for Informix databases and example values

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFORMIXDIR</td>
<td>The top level directory that contains the database client software or the entire database installation. Example: /usr/informix</td>
</tr>
<tr>
<td>On Solaris: LD_LIBRARY_PATH</td>
<td>The load library path.</td>
</tr>
<tr>
<td>On AIX: LIBPATH</td>
<td>You must add the driver location to your load library path. Examples:</td>
</tr>
<tr>
<td></td>
<td>On AIX: LIBPATH=$INFORMIXDIR/lib: $INFORMIXDIR/lib/esql: $LIBPATH</td>
</tr>
<tr>
<td></td>
<td>On HP-UX: SHLIB_PATH=$INFORMIXDIR/lib: $INFORMIXDIR/lib/esql: $SHLIB_PATH</td>
</tr>
<tr>
<td>INFORMIXSERVER</td>
<td>The default database server connection. Example: myInformixInstance</td>
</tr>
</tbody>
</table>
**DB2® databases**

The following table describes the environment variables for DB2 databases and provides example values. Contact your database or network administrator for the correct values for your system.

*Table 11. Environment variables for DB2 databases and provides example values*

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Examples</th>
</tr>
</thead>
</table>
| DB2DIR               | The top level directory that contains the database client software or the entire database installation.  
  Example: /usr/db2  
  **Note:** A script may be available to create the environment variables. For more information, see the DB2 documentation  
  Example: db2profile or db2cshrc |
| On Solaris: LD_LIBRARY_PATH | The load library path.  
  You must add the driver location to your load library path.  
  Examples:  
  On Solaris: LD_LIBRARY_PATH=$DB2DIR/lib: $LD_LIBRARY_PATH  
  On AIX: LIBPATH=$DB2DIR/lib: $LIBPATH  
  On HP-UX: SHLIB_PATH=$DB2DIR/lib: $SHLIB_PATH |
| On AIX: LIBPATH      |  |
| On HP-UX: SHLIB_PATH |  |
| DB2INSTANCE          | The default database server connection.  
  Example: myDB2Instance |

**Teradata databases**

The following table describes the environment variables for Teradata databases and provides example values. Contact your database or network administrator for the correct values for your system.

*Table 12. Environment variables for Teradata databases and provides an example*

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Example</th>
</tr>
</thead>
</table>
| TERADATA             | The top level directory that contains the database client software or the entire database installation.  
  Example: /usr/teradata |
| ODBCINI              | The location of the teradata .odbc.ini file.  
  Example: /usr/teradata/.odbc.ini |
Table 12. Environment variables for Teradata databases and provides an example (continued)

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Solaris: LD_LIBRARY_PATH</td>
<td>The load library path.</td>
</tr>
<tr>
<td>On AIX: LIBPATH</td>
<td>You must add the driver location to your load library path.</td>
</tr>
<tr>
<td>On HP-UX: SHLIB_PATH</td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>On Solaris: LD_LIBRARY_PATH=$TERADATA/lib: $LD_LIBRARY_PATH</td>
</tr>
<tr>
<td></td>
<td>On AIX: LIBPATH=$TERADATA/lib: $LIBPATH</td>
</tr>
<tr>
<td></td>
<td>On HP-UX: SHLIB_PATH=$TERADATA/lib: $SHLIB_PATH</td>
</tr>
</tbody>
</table>

Essbase databases

The following table describes the environment variables for Essbase databases and provides example values. Contact your database or network administrator for the correct values for your system.

Table 13. Environment variables for Essbase databases and provides example values

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARBORPATH</td>
<td>The top level directory that contains the database client software or the entire database installation.</td>
</tr>
<tr>
<td></td>
<td>Example: /usr/essbase</td>
</tr>
<tr>
<td>Note: A script may be available to create the environment variables. For more information, see the Essbase documentation.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: essbaseenv.csh</td>
</tr>
</tbody>
</table>
Appendix C. Changing the language of day and month names

IBM Cognos Data Manager includes configuration files so that you can use English, French, or German names for months and days. English is used by default.

You can use French or German for day and month names by replacing files with the French or German files that are provided in the installation. To use another language, you must create your own files.

Using French or German names for months and days

This topic describes how to use French or German names for months and days.

Procedure
1. In the c10_location\datamanager\message directory, back up day.gls and month.gls by saving the files using a different name.
   For example, save day.gls as dayeng.gls
2. Rename dayfr.gls and monthfr.gls, if you want to use French, or daygr.gls and monthgr.gls, if you want to use German, to day.gls and month.gls.
   French or German names for months and days are used the next time you use IBM Cognos Data Manager.

Using another language for names of months and days

This topic describes how to use a language other than English, French, or German for months and days.

Procedure
1. In the c10_location\datamanager\message directory, back up day.gls and month.gls by saving the files using a different name.
   For example, save day.gls as dayeng.gls
2. In a text editor, open day.gls.
3. Edit the file by changing the English names to the appropriate names for the other language.
   Do not add or remove any lines, and ensure that you do not add space or tab characters after the names.
4. Repeat steps 2 to 3 for month.gls
5. Save the day.gls and month.gls files, overwriting the original files.
   The names for months and days are generated using the translated files the next time you use IBM Cognos Data Manager.
Appendix D. Installation and configuration problems

This section provides solutions for problems you may encounter when installing and configuring IBM Cognos Data Manager.

Install on Windows Vista

IBM Cognos Data Manager is supported on the Microsoft Windows Vista operating system.

With Windows Vista, Microsoft introduced security enhancements to further protect the Program Files directory. If you are installing Cognos Data Manager on Windows Vista, you must consider the following:

- Roaming profiles.
  Profiles of users are stored in a different location than in earlier Windows operating systems. The Documents and Settings directory is replaced by the Users directory. The All Users directory is replaced by the Public directory.
- Environment variables.
  The default paths that are associated with environment variables has changed. If you use scripts or applications that reference these paths in the environment variables, you may need to update them.

In addition, you must reconfigure the default file locations in IBM Cognos Configuration so that a single file location can be used across operating systems in your IBM Cognos Business Intelligence environment.

Cognos Data Manager Network Services Server is not supported on Windows Vista. You should disable it during the installation process.

Start Cognos Data Manager on Windows Vista

If you have installed IBM Cognos Data Manager on a Microsoft Windows Vista operating system, you must log on as an Administrator when you start Cognos Data Manager for the first time, otherwise Cognos Data Manager is unable to write to the registry.

Stop Cognos Data Manager Network Services on HPUX and LINUX

Using config.sh -stop only stops one service. To stop more than one service, either kill the processes manually with kill -9 <pid>, or execute ./cogbootstrapservice -stop in addition to ./cogconfig.sh -stop

Upgrade Cognos Data Manager when using Cognos Data Manager Network Services

An issue exists where the Cognos Socket service fails to start after installing IBM Cognos Data Manager into the same location as an earlier version.

When installing Cognos Data Manager with IBM Cognos Data Manager Network Services the recommended approach is to first uninstall the earlier version.
Uninstall the Cognos Data Manager socket server

If IBM Cognos Data Manager Network Services is installed, configured and started on a Microsoft Windows operating system host, a file named dsnetSOCK.service is created in the following directory:

c10_location/logs/

This file is required to correctly uninstall the Cognos Data Manager Socket Server. Do not delete this file, or any other file with a .service extension, when clearing out unwanted log files from this directory.

Error messages in the SAP log when Cognos Data Manager Connector for SAP R/3 is not used

You are using IBM Cognos Data Manager Connector for SAP R/3 and the following error message appears in the SAP log:

DATASET_CANT_CLOSE

To resolve this problem, on computers where you have IBM Cognos Data Manager components installed, create a system level environment variable named SAPCOMPRESS and set the value to OFF.
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and

The following terms are trademarks or registered trademarks of other companies:
• Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.
• Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.
• Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
• UNIX is a registered trademark of The Open Group in the United States and
other countries.
• Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
Index

Numerics
64-bit installations 22

A
application servers
changing 47
startup scripts for WebLogic Application Server 51
startup scripts for WebSphere Application Server 51

B
BEA WebLogic Server 47

C
changing
Cognos Data Manager SOAP Server URI 36
network services password 35
network services port number 35, 36
cipher suites
setting a priority for SSL connections 44
Cognos BI
setting dispatcher location 39
setting gateway location 39
Cognos components
configuring 31
Cognos Configuration 4
starting 33
Cognos Data Manager
configuring 31
installing 21
uninstalling 29
Cognos Data Manager Connector for SAP R/3
installing 25
Cognos Data Manager Designer
locating additional Network Services servers 37
locating Cognos Network Services server 36
Cognos Data Manager engine 3
Cognos Data Manager Network Services
application servers 5
configuring 35, 36
enabling or disabling 38
security 5
service protocols 5
troubleshooting 73
Cognos Data Manager SOAP Server URI
changing 36
Cognos Data Manager socket server
troubleshooting 74
Cognos Data Movement Service
enabling or disabling 38
setting the Cognos BI gateway 39
Cognos service
starting 40
starting from the command line 62
stopping 40
cogstartup.xml file 62
cipher suites
setting a priority for SSL connections 44
cognitive
setting dispatcher location 39
setting gateway location 39
Cognos components
configuring 31
Cognos Configuration 4
Cognos Data Manager 3
Cognos Data Manager Network Services 35, 36
Secure SOAP 41
SSL 41

D
Data files location
configuring for Windows Vista 34
Data Manager Connector for SAP R/3 4
Data Manager Network Services 4
Data Movement Service 4
dataset errors
troubleshooting 74
DB2
environment variables 68
default installation directory for 32-bit systems 22
default installation directory for 64-bit systems 22
default settings 33
disabling
services 38
distributing components
Cognos Data Manager Network Services 5
installation scenarios 5

E
enabling
services 38
SSL for an application server 54
Enterprise archive file (EAR)
deploying to application servers 63
environment variables
DB2 68
Essbase 69
Informix 67
Oracle 65
Oracle 10G client 65
requirements on Windows Vista 34
Sybase 66
Teradata 68

© Copyright IBM Corp. 2005, 2013
stopping services 40
stopping the Cognos service from the command line 62
Sybase environment variables 66
system requirements 21

T
Teradata
environment variables 68
transfer specification file (ats)
unattended installations 57
troubleshooting
Cognos Data Manager Network Services 73
Cognos Data Manager socket server 74
dataset errors 74
HPUX 73
LINUX 73
uninstalling 74
upgrading 73
Windows vista 73

U
unattended installations 57
uninstalling
Cognos Data Manager 29
uninstalling (continued)
troubleshooting 74
UNIX manually configuring 61
starting and stopping the Cognos service 62
upgrading
java environment 31, 32
upgrading
troubleshooting 73

W
Web archive file (WAR)
deploying to application servers 63
WebLogic application server 54
WebLogic Application Server startup script 51
WebSphere application server 53
WebSphere Application Server startup script 51
Windows vista troubleshooting 73
Windows Vista requirements for file locations 34
workflows installation and configuration 17